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About This Document

This document is for Cisco System Engineers, IBM Engineers, Partners, and Customers deploying the
Cisco Identity Services Engine (ISE) Cisco Platform Exchange Grid (pxGrid) App v3.1+ for IBM the
QRadar SIEM.

The supported platforms are:

e IBM QRadar - As per recommendations for python 3 (python 2 is end of support), this is
supported on the following versions - 7.3.3 FP10, 7.4.3 FP4, and 7.4.5 or later.

e Cisco ISE 2.4 and higher with latest patch (check latest recommended release for newest code).

For this release, validation has been done with the following:

e The ISE internal CA was used for generating the pxGrid certificates for the Cisco ISE pxGrid
App.

e Various tests with 7.3.3 FP10, 7.4.3 FP4 and 7.4.5, and ISE Version 2.4, 2.7, 3.0 (with latest
patches).

e Standalone and hybrid distributed deployments.

It is also assumed that the reader is familiar with both IBM QRadar SIEM and Cisco ISE.

Note:  As of July 2021, this guide is written using ISE 3.0 and 7.4.3FP4 as a reference. If you're looking
for older version of guide and screenshots, please use app version guide 2.x at http://cs.co/ise-
guides. The screens for ISE 3.x are slightly different but operationally the same.

This document provides the details of installing and configuring the Cisco ISE pxGrid App for the IBM
QRadar SIEM. The Cisco ISE pxGrid App provides Dashboards for Passed Authentications, Failed
Authentications, Devices, Compliances, TrustSec, Mobile Device Management (MDM), and Currently
Assigned ANC Policies.

Cisco Adaptive Network Control (ANC) mitigation actions can be taken directly from the Dashboards
to quarantine endpoints according to an organization’s security policy. These ANC mitigations can
also be enforced via IBM QRadar SIEM syslog events as long as the endpoint has been authenticated
through ISE.

The Cisco ISE pxGrid App contains an IBM QRadar pxGrid offense rule which is based on pxGrid
RADIUS failure topic events.

The contextual information can be obtained from the IP Address of syslog events as long as the
endpoint has been authenticated through IS.



https://www.ibm.com/support/pages/node/6356547
http://cs.co/ise-guides
http://cs.co/ise-guides
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Solution Overview

IBM® QRadar® SIEM detects anomalies, uncovers advanced threats, and removes false positives. It
consolidates log events and network flow data from thousands of devices, endpoints, and applications
distributed throughout a network. It then uses an advanced Sense Analytics engine to normalize and
correlate this data and identifies security offenses requiring investigation. As an option, it can
incorporate IBM X-Force® Threat Intelligence which supplies a list of potentially malicious IP addresses
including malware hosts, spam sources, and other threats. QRadar SIEM is available on premises and in
a cloud environment.

Cisco ldentity Services Engine (ISE) is a security policy management and identity access management
solution. ISE provides centralized management by defining, issuing, or enforcing 802.1X authentications,
guest access management, policies, posture, client provisioning, and TrustSec policies. The ISE session
directory contains a wealth of information about the endpoint that is published by Cisco Platform
Exchange Grid (pxGrid).

ISE also simplifies access control and security compliance for wired, wireless, and VPN connectivity and
supports corporate security policy initiatives such as BYOD.

Cisco Platform Exchange Grid (pxGrid) enables multivendor, cross platform network system
collaboration among parts of the IT infrastructure such as security monitoring and system detection,
network policy platforms, asset and virtually configuration management identity and access management
platforms and other IT solutions. pxGrid uses a pub/sub model to publish the contextual information
received from ISE, and other security solutions will subscribe to this topic, providing more visibility into
security operations. Other security solutions can use pxGrid to enforce their security policies.




SECURE ACCESS HOW-TO GUIDES

Technical Details
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The Cisco ISE pxGrid App installs on an IBM QRadar SEIM instance as an IBM signed app. Once the app
is installed, the Cisco ISE pxGrid App will be registered as a pxGrid client to the ISE pxGrid node and

subscribe to topics and consume contextual information to populate the Dashboards and take Adaptive
Network Control (ANC) mitigation actions.

The following image is a single standalone ISE 3.0:

e Go to Administration > pxGrid Services > Diagnostics > WebSocket.

Not Summary Client Management Diagnostics Settings
WebSocket
Clients Topics
Clients

£7 Refresh

Client Name

X Client Name

ise-fanout-ise

ise-mnt-ise

ise-admin-ise

ise-bridge-ise

ise-fanout-ise

Subscriptions

Subscriptions

/topic/wildcard

/topic/com.cisco.ise.session.internal

/topic/com.cisco.endpoint.asset,/topic/com.cisco...

/topic/distributed

Rows/Page

Publications

Publications

/topic/com.cisco.ise.session.internal

/topic/com.cisco.ise.pxgrid.admin.log,/topic/com.cisco.ise.t...
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The following image is for a distributed deployment of PAN, MNT, and 2 PSN/pxGrid Nodes on ISE 2.7:

cisco

=l |dentity Services Engine Home

~Adminisiration

» System » Identity Management » Network Resources » Device Portal Management = pxGrid Services » Feed Service  » Threat Centric NAC

Click here fo do wireless setup Do not show this again.

All Clients Web Clients Capabilities Live Log Settings Certificates Pemnissions
—

Rows/Page | 25 v 1 11 Go | 14 Tolal Rows
© Refresh T Filter= -2
Client Name }¥ Connect To Session Id Certificate Subscriptions Publications. IP Address Status Start time Durat
x v P Address ~
ise-mnt-ciscoiseprimnt ciscoisepripsn ciscoisepripsn:94552 Mo Certificate ftopic/com.cisco.ise.se... /lopic/icom.ciscoisese... 192.168.0.136 ON 2021-04-03 05:40:17 IST 00:15:49:26
ise-fanout-ci ciscoisesecpsn ciscoisesecpsn 94442 CN=ciscoisesec.. ftopic/wildcard Mopicicom.ciscoise.se... 127.0.0.1 ON 2021-04-05 06:08:03 IST 03:15:21:40
ise-fanout-ciscoisesecpsn ciscoisepripsn ciscoisepripsn: 94538 CN=ciscoisesec.. ftopic/distnbuted Mopic/distributed 192.168.0.139 ON 2021-04-07 06:02:13 1ST 01:15:27:30
ise-fanout-ciscoisepripsn ciscoisepripsn ciscoisepripsn-94322 CN=ciscoisepnp. ftopic/wildcard ftopic/icom ciscoise se 127.0.01 ON 2021-03-24 05:58:18 IST 15:15:31:25
ise-fanout-ciscoisepripsn ciscoisepripsn ciscoisepripsn-94493 CN=ciscoiseprip. ftopic/distributed ftopic/distributed 192.168.0.138 ON 2021-04-05 17:40:51 IST 03:03:48:52
ise-bridge-ciscoisesecpsn ciscoisesecpsn iscoisesecpsn 94445 CN=ciscoisesec.. 127.0.0.1 ON 2021-04-05 06:09:12 IST 03:15:20:31
ise-bridge-ciscoisepripsn ciscoisepripsn ciscoisepripsn:94467 CN=ciscoiseprip... 127.0.01 ON 2021-04-02 05.57:55 IST 06:15:31:48
ise-admin-ciscoisesecpsn ciscoisesecpsn ciscoisesecpsn 94444 CN=ciscoisesec.. 192.168.0.139 ON 2021-04-05 06:09:02 IST 03:15:20:41
ise-admin-ciscoisepripsn ciscoisepripsn ciscoisepripsn:94481 CN=ciscoisepnp... ftopic/com.cisco.endpo...  Mtopicicom.ciscoiseco...  192.168.0.138 ON 2021-04-04 06:04:46 IST 04:15:24:58
ise-admin-ciscoiseprimnt ciscoisesecpsn iscoisesecpsn 94453 CN=ciscoiseprim ftopic/icom cisco ise fel 192.168.0.136 ON 2021-04-03 05:40:17 IST 00:15:49:27
QRadarApp. st_6thApr ciscoisesecpsn iscoisesecpsn 94452 CN=gradari24.a ftopic/com cisco ise se 192.168.1.124 ON 2021-04-07 06:05:51 IST 01:15:23:52
QRadarApp_QATest_6thApr ciscoisepripsn ciscoisepripsn:94553 CN=gradari24.a ftopic/com.cisco.ise.se... 192.168.1.124 ON 2021-04-08 05.55:58 IST 00:15:33:45
QRadarAppST ciscoisesecpsn ciscoisesecpsn 94451 CN=gradari24.a ftopic/com.cisco.ise.se... 192.168.0.76 ON 2021-04-07 06:02:24 IST 01:15:27:19
QRadarAppST ciscoisepripsn ciscoisepripsn:94554 CN=gradar124.a ftopic/com.cisco.ise se... 192.168.0.76 ON 2021-04-08 05:56:23 I1ST 00:15:33:21

The Cisco ISE pxGrid app pxGrid client subscribes to the Session Directory, RADIUS failure, MDM
endpoint, and ANC configuration Topics.

The Session Directory topics consist of user contextual information, such as username, MAC address, IP
Address, endpoint device, posture status and provides wired and wireless connection type information.
Wired connection type information includes the NAS Port ID, NAS IP Address, NAS Port Type, Location,
and Device Type attributes. Wireless connection type information includes WLAN, Calling Station ID,
Called Station ID, NAS IP, Device Type, Location, and NAS ldentifier attributes.

The MDM topic consists of compliance and registration status and is dependent on having an external
MDM solution configured in Cisco ISE. In this document, the Cisco Meraki Solution was used as the
external MDM solution. The testing was done with ISE 2.4 initial release so only the compliance and
registration status attributes were available. In later releases of Cisco ISE after 2.4, the MDM attributes
are available as follows: Manufacturer, UDID, Serial Number, Encryption Status, Jail Broken Status, Pin
Lock Status.

The RADIUS failure topic includes failure reason attributes, such as "invalid password" and drill downs
based on location and wired/wireless connection types.

The Config ANC Status Topic provides the Cisco ISE pxGrid client app to perform ISE Adaptive Network
Control (ANC) mitigation actions on the endpoints.

The Cisco ISE pxGrid App uses pxGrid 2.0, which uses WebSocket, REST API, and STOMP messaging
protocol for pxGrid operation and thus supported since Cisco ISE 2.4.
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Cisco ISE pxGrid Installation

Make sure that you have installed Cisco Identity Services (ISE) 2.4 or higher and it is in a standalone
deployment (also supports other deployment methods). If this is a production ISE deployment, ensure
the Cisco ISE pxGrid node is on a dedicated node. See the pxGrid section of ISE Guides for more
information.

At minimum, it is recommended to have two standalone nodes for HA purposes. Both nodes would be
running all personas, including pxGrid. Depending on the number of clients and architecture
requirements, you may expand into other architecture designs. Please consult with your ISE integrator on
recommended deployment model.

Go to Administration > System Deployment > Edit the ISE node > Enable pxGrid.

This image is for ISE 2.7. For ISE 3.0, the image doesn’t fit well on a screen. You would need to

Step 1 .
ep scroll down to the bottom and enable pxGrid.

Hostname
FQDN
IP Address
Node Type Identity Services Engine (ISE)
Role STANDALONE Make Primary
v Administration
w Monitoring

Role PRIMARY v
Other Monitoring Node

w Policy Service
v| w Enable Session Services ‘i
Include Node in Node Group None v |G
Enable Profiling Service i
O Enable Threat Centric NAC Service i

[CJ  » Enable SXP Service i

0O Enable Device Admin Service i
0O Enable Passive Identity Service i
pxGrid i



https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/216120-ise-security-ecosystem-integration-guide.html#anc31
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Selected 0 Total 1 (5  45%
IRV v4

Node Status

Deployment Licensing Certificates Logging Maintenance Upgrade Health Checks Backup|
~  Policy Service
v Enable Session Services (O
Include Node in Node Group
None v ®
Enable Profiling Service (1)
Enable Threat Centric NAC Service (1)
~  Enable SXP Service (O
Use Interface GigabitEthernet 0 v
Enable Device Admin Service (1)
[7] Enable Passive Identity Service (7)
@) pxGrid ()
Select Save.
Step 2
You should see the following (ISE 3.0):
O Hosthame ~ Personas Role(s) Services
E] ise Administration, Monitoring, Policy Service, pxGrid STANDALONE

Recommended Distributed deployment example (ISE 2.4+):

Deployment Nodes

# Edit m Register 3 Syncup ﬂDeregisber

»

[] ' Hostname »  Personas

O ciscoiseprimnt Administration, Monitoring
O ciscoisepripsn Policy Service, pxGrid

O ciscoisesecmnt Administration, Monitoring
O ciscoisesecpsn Policy Service, pxGrid

Role(s)
PRI(A), PRI(M)

SEC(A), SEC(M)

TC-NAC,SESSION,PROFILER,SXP,DEVICE ..

Selected 0 | Totsl ¢ @ 4G5

Show | All

-]

Services

MOME
SESSION,PROFILER.
NOME
SESSION,PROFILER.

Mode Status

oooB

Cisco Systems © 2021
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Select Administration > pxGrid Services > Summary.
Verify that the published nodes appear. All nodes running pxGrid will have a fanout & pubsub.
In ISE 3.0, you may see services not available. This is fixed in patch 3.

The screenshot below shows that 1 pxGrid client is connected (this is a current setup with
another vendor that we are showcasing with 5 pubsub connections (internally and to 1 client).

Step 3
Administration - pxGrid Services Q @ 8

= Cisco ISE
Summary Client Management Diagnostics Settings
ACTIVE CONNECTIONS LAST HOUR ACTIVITIES
Pubsub connections Control messages REST API Pubsub Throughput
5 3 98 1 5 O . ] 4 Kbps
Last refreshed: 2021-04-08 12:47:00
TOTAL CLIENTS (1) = ERRORS (1)
Total Clients Last Hour Activities
R Message bast Oceured
No data found.
® Approved 1(100%)
0 (0%)

Pending

Page 10

Cisco Systems © 2021
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Select Web Clients (Diagnostics > WebSockets in ISE 3.x) and verify that the published nodes

appear:

This is validating pxGrid 2.0 connections. You should see that admin, mnt, and pxGrid
nodes have connections with each other. They should all be ON. This is from a 4-node
deployment.

Step 4
P ‘tues’ Identity Services Engine Home » Context Visibility » Operations » Policy ~ Administration » Work Centers

» System

x
ise-mnt-ise
ise-admin-ise
ise-admin-ise3
ise-admin-ise2
ise-admin-ise4
ise-fanout-ise4
ise-fanout-ise3
ise-bridge-ise3
ise-fanout-ise3
ise-fanout-ise4

ise-mnt-ise2

» Identity Management

ised

» Network Resources

ise3:1
ise3:2

ise34

» Device Portal Management

No Certificate

CN-=ise.security
CN=ise3.securit
No Certificate

CN=ised securit
CN=ised.securit
CN=ise3.securit
CN=ise3.securit
CN=ise3.securit
CN=ised. securit

No Certificate

pxGrid Services

fopic/com.cisco.ise.s

Ropic/wildcard

Ropic/wildcard

Ropic/distributed
Ropic/distributed

Ropic/com.cisco.ise.s

» Feed Service

Ropic/com.cisco.ise.s

Ropic/com.cisco.ise.s

Ropic/com.cisco.ise.s

Ropic/distributed
Rtopic/distributed

Ropic/com.cisco.ise.s

» Threat Centric NAC

10.1.100.21 ON
10.1.100.21 ON
10.1.100.23 ON
10.1.100.22 ON
10.1.100.24 ON
127.0.01 ON
127.0.0.1 ON
127.0.01 ON
10.1.100.23 ON
10.1.100.24 ON
10.1.100.22 ON

Cisco Systems © 2021
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Generating the Cisco ISE pxGrid App Certificate

A certificate for the Cisco ISE pxGrid App will be generated from the ISE internal CA so the App will
register and connect to the ISE pxGrid node. If you are using an external CA server for pxGrid
operation, please see pxGrid section of the ISE Guides.

For more information on certificates, please refer to this section under cs.co/ise-qguides.

Note: ~ When deploying certificates to your ISE nodes, make sure that the root that is installed on the

Grid pede is that gf the certificate issued t Grid nodes. . . . .
e Select Administra ?&ﬁsi“‘E)xé¥? 'Services > Certificates éIIMSE_t%ig,EJr) or Administration > pxGrid
o Wi

e e MRS B AR SRR % G PREUEATSR ALk cdokh-is uide)

Step 1 .
You should see the following:

sslualis  Identity Services Engine Home  » ContextVisbity  » Operations  » Policy [l tie Ul

» System » Identity Management  » Network Resources  » Device Portal Management = pxGrid Services | » Feed Service  » Threat Centric NAC

All Clients Web Clients Capabilities Live Log Settings Certificates Permissions
Le——————¢]

Generate pxGrid Certificates

Iwantto* :J

Common Name (CN) *

Certificate Template PxGrid_Certificate_Template @

Subject Alternative Name (SAN) j
Certificate Download Format * j e
Certificate Password * e

Ste Confirm Password

Connected to pxGrid Ise24k.lab10.com

Type the following:

It is recommended to use the full name of the server ex: gradar.securitydemo.net.

Cisco Systems © 2021 Page 12


https://www.cisco.com/c/en/us/support/docs/security/identity-services-engine/216120-ise-security-ecosystem-integration-guide.html#anc31
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This is the IP address and FQDN of your QRadar system. You are generating a
certificate here to install on QRadar app so it can present when communicating with ISE.
| want to: Generate a single certificate (without a certificate signing request)
Common Name (FQDN): qgradar.securitydemo.net
Note: Description: QRadar
Certificate Template: Pxgrid_Certificate_ Template
Subject Alternative Name (IP Address): 10.1.100.27
Subject Alternative Name (FQDN): qradar.securitydemo.net

Certificate Download Format: Certificate in Privacy Enhanced Mail (PEM) format, key in PKCS8
PEM format including certificate chain

Certificate Password.: XXXXxxxx

Confirm Password.: xxxxxx

Select Create.

Sep s This will create a zipped file 1520701037382_cert.zip.

Note: Make sure your browser pop-up blocker is disabled when generating certificates.
Step 4 Unzip the file, you will see the following files:

Note: Keep the original zip, we are exporting here to just look at the contents and discuss the

certificate. However, the QRadar App is able to import the zip package with its key as
well.

= | 1593541041500_cert

Home Share View

<« v > ThisPC » New Volume (E:) » 1593541041500_cert
I Desktop 2 Name : Date modified Type

¥ Downloads  # 5] CertificateServicesEndpointSubCA-ise_ 6/30/2020 6:177PM  Security Certificate
= Documents = CertificateServicesNodeCA-ise_ 6/30/2020 6:17 PM Security Certificate
| Pictures 4 = CertificateServicesRootCA-ise_ 6/30/2020 6:17 PM Security Certificate
CESAPOVKit20mr &) gradar.securitydemo.net_gradar.securitydemo.net 6/30/2020 6:17 PM Security Certificate

. || gradar.securitydemo.net_qradar.securitydemo.net.key 6/30/2020 6:17 PM KEY File
gl SSL.comDVCA_ 6/30/2020 6:17PM  Security Certificate
& This PC =) USERTrustRSACertificationAuthority_ 6/30/2020 6:177PM  Security Certificate

P 3D Objects

The QRadar identity certificate consists of the public private key-pair:

gradar.securitydemo.net_qgradar.securitydemo.net.cer
gradar.securitydemo.net_qgradar.securitydemo.net.key

Cisco Systems © 2021 Page 13
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The CertificateServicesRootCA-ise_.cer is the ISE internal Root CA certificate.

Depending on your setup, you may have certificates being used for different ISE personas in your
environment. If pxGrid is not assigned to the local Certificate services endpoint, as seen below, then
make sure that you export the root certificate chain that was used to sign it. For example, if you have ISE
signed up an external identity source.

Don’t assign pxGrid to the self-signed certificate of ISE. This is not the best practice. If it moves pxGrid
back to the Certificate Services Endpoint Sub CA as you can see in the image below. If for some reason
you need this, then you will need to manually export this certificate and upload as package with the
internal CA generated cert and key to QRadar and choose that as the root. The relevant certificates from
the internal CA won’t matter even though they are in the package.

In the following example, the pxGrid certificate is signed by the same ISE internal CA. When ISE
communicates to QRadar system, it will present this as part of the communication. When you generate
the certificate on ISE in the above steps, it gives you a package that includes the certificate chain from
ISE internal CA. When QRadar talks to ISE, its certificate is automatically accepted because ISE is aware
of the certificates it issues and the associated certificate chain.

<« c @ © & % https;//9.21.118.93/admin/#administrat

;‘-'u"; Identity Services Engine Home » Context Visibility » Operations » Policy w Administration » Work Centers

~ System » Identity Management  » Network Resources » Device Portal Management  pxGrid Services » Feed Service » Threat Centric NAC

Deployment  Licensing ~Cerificates  » Logging  » Maintenance  Upgrade  » Backup & Restore  » Admin Access  » Seftings

o
~ Certificate Management System Certificates For disaster recovery itis recommended to export certificate and private key pairs of all system certificates
System Certificates JE H‘E Generate Self Signed Certficate :‘}- Import & E ¥ D¢ '
Trusted Certificates Friendly Name UsedB Portal group tag Issued To Issued By
OCSP Client Profile Tabpds
Certificate Signing Requests O i oM ':fﬁw7"'3t6 Senvices Endpoint Sub CA- b

Certificate Periodic Check Setti
Certificate Services Endpoint Sub CA-b
p02

: bp02.canlab.ibm.com

» Certificate Authority Services Endpoint Sub C

Fffau“ t samL SAML_bp02.canlab.ibm.com SAML_bp02.canlab.ibm.com

Portal, EAP

d server certificate Authentication, RADIUS Default Portal Certificate Group i bp02.canlab.ibm.com
DTLS

Default self-signe bp02.canlab.ibm.com

Cisco Systems © 2021 Page 14



SECURE ACCESS HOW-TO GUIDES ciISCO

Installing Cisco ISE pxGrid App

In this section, you will learn how to install the Cisco ISE pxGrid App.

To download the app, please visit the IBM App Exchange.

If user is upgrading the Cisco ISE pxGrid QRadar App, we recommend users to uninstall the old app and
NotLQSthkstmumégﬁgyﬁmiaq{]nning recommended release of IBM QRadar (see notes at the beginning

of this document).

To uninstall the old app:

Go to Admin > System Config > Extensions Mgmt.
Select Cisco ISE pxGrid, and then click Uninstall.

1.
2 Extensions Management Search by extension name
ALL ITEMS INSTALLED NOT INSTALLED
Hame

Cisco ISE pxGrid

The Cizsco ISE pxGrid App uses Cisco ldentity Services Engine (ISE) 2.4 + and leverages Cisco Platform Exchange
Grid (pxGrid) to orchestrate all communication and data interchange [ exchange betvween IBM GRadar and Cisco
ISE. This provides ISE contextual information from within the QRadar console. The App has dashboards that
provide key information such as Passed and Failed authentications, Device Summary, Compliance, TrustSec and
MDM. It alzo alloves the QRadar admin to take right-click Adaptive Network Control (ANC) mitigation actions for
Rapid Threst Cortainment (RTC)

Uninstall

(More Details...)
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Install the extension:

In IBM QRadar, select Admin > Extensions Management.

IBM QRadar
Step 1
a. = 8
Admin @ Deploy Changes Advanced ¥V

v System Configuration | . There are no changes to deploy.
: H:f;!tanagemeﬂt Roasons

» Data Sources 0

5 | %

Remote Networks and < b Wiery Q
Services Configuration Routing Rules Domain Management Extensions Mandagement Re
Try it out

» Apps User Management

Click Add a New Extension, upload the signed Cisco ISE pxGrid App, and select the Install
b.

Immediately checkbox.

ALL ITEMS

Add a New Extension

From local storage

|Cisco_ISE_pxGrid_v2.0.0_03092020 zip Browse

! linstall unme*ie“y

Add Cancel
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If asked the following, select the Replace option to install new components, and click
Install at the very bottom.

Cisco ISE pxGrid
By: Cisco
) i\ The extension contains 3 items which are already on the system and marked with REPLACE. You can replace these
Note: items with the versions in the extension that you are about to install, or you can preserve existing items as-is and add
only new items. Application items that are marked with REPLACE are upgraded but internal data and configuration is

preserved. Customizations to system Custom Rule items are preserved. Any other item types marked with REPLACE will
be replaced and customizations will be lost. How would you like to proceed?

@ Replace existing items. (Application data is preserved)
Preserve existing items. (Not recommended for applications)

By installing this extension, the following changes will occur in the system:

Log Source Extensions (1)

Next you may see this: Click OK.

Cisco ISE pxGrid
By: Cisco

The extension has been installed successfully. Please review the install summary:

This extension contains one or more applications. In order for all new user interface elements to appear and function correctly, it
is necessary to refresh your browser. It may also be necessary to clear your browser cache.

DSM Event Mappings (2)
4001:QRadarAppForPxGrid:User Sessions ADD
4001:QRadarAppForPxGrid:Radius Failure ADD

Custom Applications (1)

Cisco ISE pxGrid INSTALL
C.
Note:  After installation, you should see the following:
This is showing an exclamation as we were testing with an unsigned copy before
posting to IBM app exchange.
Extensions Management | Search by extension name Q IBM Security App Exchange |
d- Name Status Author Added On -
Step 2 | owoscrcn -
a.

Clear the browser cache, close the browser, launch the app, and login again.

Configure the logging IP address for the primary/secondary nodes:
On QRadar, in the upper-left corner, click the hamburger.

Navigate to Admin > Data Sources > Events > Log Sources.
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IBM QRadar

Admin b Deploy Changes Advanced ¥V

i) There are no changes to deploy.

» System Configuration

v Data Sources Data Sources

« Events
N Events

« Flows

« Vulnerability 5
4 @ 4

DSM Editor WinCollect Log Sources @

Remote Networks and

Services Configuration

Try it out

Change your log source identifiers QRadar 7.3 (see 7.4 below this section).

c. Choose Name > pxGrid_Primary/pxGrid_Secondary.
Edit and change the Log Source Identifier to corresponding ISE IP for Primary and
Secondary accordingly.
You may disable the secondary if you don’t need it.

§ Log Sources - Google Chrome = O et
A Not secure 192.168.1.233/console/do/sem/maintainSensorDevice
Search For: | Group w | [All Log Source Groups Go [|add [y Edit [f] Enable/Dissble () Delete  Bulk Actions ¥ (7]
i Extensions &, Parsing Order Ei Assign
Log Source Log Source Target . !

Not Name Desc Status Protocol G.. Type Enabled Identifier Destination Credibi Autodiscov
pxGrid_Primary Cisco ISE ..  Success | Syslog Clsco ISE pxGrid | True primary eventcolle... | & False
pxGrid_Secondary Cisco ISE ... | Success | Syslog Clsco ISE pxGrid | True secondary eventcolle... | 5 False

Not Search For:| Name | [pxciid Go |&dd [ Edit ¥elEnableDisable €3 Delete  Bulk Actions ¥ @WExtensions . Parsing Order [ 4ssign (2]
Log
Name & Desc Status Protocol Group Source Enabled L:Jdg ngl‘lrce DT:;ge:‘
Type entifier estinatia
pxGrid Cisco ISE pxGrid Log Source for pri...  Error Syslog Clsco IS... True primary eventcoll...
prGrid Cisco ISE pxGrid Log Source for se...  Error Syslog Clsco IS, True secondary eventcoll...

Page 18
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Edit a log source

J’/ Mote that the connection information for this log source is shared amongst one or more other log sources.,

0 ERROR - Events have not been received from this Log Source in over 720 minutes.

Log Source Hame |p}{G rid

Log Source Description |Cisco ISE pxGrid Log

Change your log source identifiers for QRadar 7.4.

e The app opens in a new window.
4. * Choose Log source type to filter on pxGrid.

IBM QRadar Log Source Management

Status (5) Clear
OK 0
Ll Log Sources (2) L3 N7
[T wamning 0
[] Error 2
D Not Available 0 D D Name ~ Log Source Type Creation Date Last Event Enabled
[] Disabled 0
[(] 262 pxGrid_Primary Clsco ISE pxGrid  Aug 12,2020 7:52AM  Sep 1, 2020 5:48 AM
Enabled (2)
[ ves ? [[] 212 pxGrid_Secondary Clsco ISE pxGrid  Feb 10, 2020 10:53 PM  Aug 24, 2020 6:33 AM @
D No
Log Source Type (9)
20 ~ items per page 1-2 of 2 items 1 of 1 pages 1

Clsco ISE pxGrid

N

note: ® Change the primary and secondary log source identifier.
e Click on the primary, edit, and then choose protocol. Change Primary to actual ISE pxGrid node

IP, and then click Save.
Do the same for the secondary. If one is not used, then disable the toggle slider as in

the image above.
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pxGrid_Primary

E Clsco ISE pxGrid

pr
Status: Error

Last Updated 9 hour

/\ Events have not been received from this Log Source in over 720 minutes.

Overview Protocol

R

10.1100.23

Log Source Identifier *

Incoming Pavload Encoding

¢ Close the edit window, and then the second browser tab.

Configure the Authorized Services in QRadar:

Step 3 . . . . .
Select Admin > System Configuration > User Mgmt > Authorized Services.
a.
Dashboard Offenses Log Activity Network Activity Assets Reports Admin Pulse
Admin 0 Deploy Changes Advanced ¥
v System Configuration I i) There are no changes to deploy.
« User Management
» Assets System Configuration
» Data Sources User Management
Remote Networks and O -/}‘ @) i "
Services Configuration o _ X
Users User Roles Security Profiles Authentication @honzed Services Ten
Try it out
» Apps

Add Authorized Service:

¢ In the Service name box, enter pxGridService.

¢ In the User Role and Security Profile dropdown lists, select Admin (default).
e Select the No Expiry checkbox.
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sk pxGridService
User Role: | Admin j
Security S
Profile: Admin ~
Expiry Date: 2/13/2018 ~ | /v No Expiry

Click Create Service.

Copy the authentication token into the notepad.

| |Add Authorized Service () Delete Authorized Service | Edit Authorized Service Name Selected Token:c8342c8c-fb96-48bd-ab93-912754c56872
Service Name Authorized By Authentication Token User Role Security Profile Created Expires
prGridService admin | cB34208c-096-4Bbc-a.. |Admin |Admn | Apr9, 2021, 5:09:27 PM | Pormanent |

This is later used for Cisco ISE pxGrid App for pxGrid integration.

Note: Close the Authorized Service browser window.

Make sure to deploy changes at this point.

) Deploy Changes  Advanced ¥

/A, There are undeployed changes. Click ‘Deploy Changes'to deploy them. View Details
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In QRadar 7.4.3+ ,Authorized Service Management has a different Ul

Authorized Service Management -]

Filter Search Results

User Role {1}
[ Admin 4

Security Profile (1)

[ Admin 4+ Pugrid

Click on Add to create a new token or edit the existing token.

New Authorized Service X Edit Authorized Service X

Authorized Service Labe

Authorized Service Label

Search Authorized Service

Admin

| ]

Permissions

Security Profile

Admin

User Role

Admin

Expiry Settings

Manage Security Profiles
b

Manage User Roles

e

This Authorized Service expires
19-03-2022

14.57

Cancel

- O
o

®

User Role

Security Profile Authorized By LastUsed

Admin admin Thu, 1702/2022. 12:31 pm

Authorized Service Laba

Pxgrid

Permissions

Security Profile Manage Security Profiles

Admin v
User Rale Manage User Roles
Admin W

Expiry Settings

This Authorized Service expires

@ )

| Cancel || Delete |

Expires

ST
CIsCcoO
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Configuring pxGrid Integration on QRadar

Setup pxGrid settings:
Select Admin > Apps > Cisco ISE pxGrid > pxGrid Settings.

IBM QRadar

Offenses Log Activity Network Activity Assets

Step 1

) Deploy Changes  Advance. 'RJ
a.

l J) There are no changes to deploy.

Apps
Cisco ISE pxGrid

mote Networks and dlialn
3 cisco

pXGrid Settings

b Copy and paste the authentication token into the QRadar Service Token Window.

QRadarSettings ISESettings Policies HealthAuditLog

QRadar service token * ©8342c8c-fh96-48bd-ab93-912754¢56872

Time interval to invoke the scheduler in 5
minutes *

QRadar event collector * 198.18.133.50,

Clear Save & Continue
Note:

Not Connected to any server.

Note: When going through the setup, you will notice the following message at the bottom of

the app. This is due to the config not being completed. You won’t see it change to
green until all configuration is completed and polling is done via HealthAuditLog.

If you continue to see this after putting all the settings in and ISE shows Enabled then
clear your browser cache to refresh.
Step &

Problem in connecting the ISE servers - ISE Settings are missing in the app.

Enter the QRadar Event collector (EC) IP / QRadar Console IP (If EC is not available).
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Select Save & Continue, this will move you to the ISESettings tab.
Select Primary and type the IP address of the ISE pxGrid node.
Leave 8910 as the default port.

Enter the Client username (for example, QRadar App).

Step 3
Step 4 This will be the unique registered pxGrid client name displayed on ISE.
Step 5 Select the certificate format type. You can choose between PEM or Pkcs12(.p12).
Step 6
Note: YOU May upload the zip package you generated from ISE certificate services (ISE internal CA);
otherwise, if you’re using your own internal PKI, you can upload all (selecting all in the
Step 7 browse windows at once) the Cisco ISE pxGrid App certificates in the PEM format under
Step 8 Select and Upload Certificates (only PEM is supported) application settings page.
CertificaeServicesEndpointSubCA-ise24k_.cer
CertificateServicesNodeCA-is24k_.cer
CertificateServicesRootCA-ise24k_.cer
ise24k._cer
gradar.labl1@.com_gradar.labl0.com.cer
gradar.lab10.com_gradar.labl0.com.key
Step 9 Choose the Cisco ISE pxGrid App Certificate file name:
qradar.lab10.com_qradar.lab10.com.cer.
Step 10 . . . .
tep | Choose the Cisco ISE pxGrid App Certificate key file name:
< gradar.lab10.com_gradar.lab10.com.key.
tep 11

Choose the Cisco ISE Internal Root Certificate Root CA certificate file name:
gradar.lab10.com_qgradar.lab10.com.cer.
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Enter the certificate pass phrase.

Click on enable encrypted certificate key and enter the passphrase when the text box appears

You will see the following if PEM format is selected:

Step 12 o . - ) _
QRadarSettings ISESettings Policies HealthAuditLog HelpandSupport
PxGrid Mode 1 1P Address 192.168.0.138
PxGrid Node 2 IP Address 192.168.0.13d
Part * 8910
Client user name QRadarApp
Certificate format type * PEM format (Only zip or individual certificate files are supported.) =

Select & Upload certificates * Choose Files | Mo file chosen

Enable encrypted certificate key

Certificate file name * 3
Root CA certificate file name = 3
Certificate key file name = 3
Certificate passphrase

Clear Save & Continue

You will see the following if PKCS12 format is selected:

QRadarSettings ISESettings Policies HealthAuditlog HelpandSupport
PxGrid Node 1 IP Address 192.168.0.138
PxGrid Node 2 IP Address 192.168.0.139
Port * 8910
Client user name CQRadarApp
Certificate format type ~ PKCS#12 format (Only #12 file is supported.) ¢

Select & Upload certificates * Choose Files | gradar7s0.aujas.com_Aujas123_192.168.1.232unenc.p12

Enable encrypted certificate key

Certificate file name = qradar750.aujas.com_Aujas123_192.168.1.232unencp12 :
Certificate passphrase

Clear Save & Continue
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When working with certificates, you must understand where the certificate was issued for your pxGrid
nodes. Here are some criteria:

On any ISE deployment, you could have multiple certificates for different roles personas.

The admin node with an internal PKI certificate so that your admin machines with the root trust
them.

Portals for guest services would likely have a well-known certificate so that any client coming in
off the street can trust the portal.

Your pxGrid node will likely be side either by ISE internal CA or a well-known certificate root,
depending on how you certificate trust is set up. Carefully choose your Root in the setup
settings.

All nodes running pxGrid should have the same root.

See more about certificates at ISE Guides page for certificates and ISE 2.7 Certificate Section of
Admin Guide.

If adding a secondary pxGrid node, provide the secondary pxGrid Server IP Address, the Client
username and identity certificate, and public private key-pair. The root certificate will remain the
same as in Primary.

At the bottom of the page, select Save and Continue.

At this point you will see a screen to sh9w pxGrid policies. It will be empty since ISE comes out c_)f . .
box notYotemiil] fze provideehtivithrar rressage=toyapproviegelienthadtiaeection. You can ignore if auto

testing. 43RV RECRIPADTRY . ISEE BteF'SPprove client connection in provided below.

Administration > pxGrid Services > Settings (ISE 3.x)

Administration > pxGrid > Settings (ISE 2.4+)
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= Cisco ISE Administration - pxGrid Services
Summary Client Managemant Diagnostics  Settings
A PxGric 1.0 is in maintenance made and will be deprecated soon. Upgrade the parter systems to pxGrid 2.0 o
Settings
o

Use Default

All Clients Web Clients Capabilities Live Log Settings
e

PxGrid Settings

[ Automatically approve new certificate-based accounts
[C] Allow password based account creation

Use Default

Let’s allow the connection manually:

Step 13 Admin > pxGrid Services > Client Management (ISE 3.x), and click to Approve the gradarapp.

Admin > pxGrid Services > All Clients (ISE 2.4+), click Approve all.

= Cisco ISE Administration - pxGrid Services
N 5 Click here to do visibility setu|
Summary Client Management Diagnostics Settings v v
Glients
Policy PxGrid 1.0 is in maintenance mode and will be deprecated soon. Upgrade the partner systems to pxGrid 2.0 compatible
version
Groups
Centificates C|Ient5
Rows/Page 2 1 A
) refresh ) Trasn v 7 Edit {7 Approve ) Decline
Name Description Client Groups Status
stealthwatch ANC + Enabled
aradarapp PXGrid App for Qradar + Fendin
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el Identity Services Engine

Home » Context Visibility » Operations » Policy ~ Administration » Work Centers

» System  » Identity Management  » Network Resources  » Device Portal Management  pxGrid Services ~ » Feed Service  » Threat Centric NAC
Click here to do visibility setup Do not

All Clients Web Clients Capabilities Live Log Settings Certificates Permissions

of/Enable @ Disable @Approve © Group Qoechne Qodete - {ARefresh Total Pending Approval(1) « 1selecteditem 1-80f8 Show 25 «
O Client Name Description Cap m:;iﬁﬂ Status Client Group(s) Auth Method
O » ise-mntise CapaonmesTZ Pun; 1 suny Online (XMPP) Internal Certificate

O » ise-fanoutse Capabilities(0 Pub, 0 Sub) Online (XMPP) Internal Certificate
Oo» apal Online (XMPP) Internal

O » & Capabili Online (XMPP) Internal Certificate

O » ise-admin-ise Capabilities(S Pub, 2 S Online (XMPP) Internal Certificate

P gradar pXGrid App for Qradar Capabilities(0 Pub, 0 Sub) Pending Certificate

O » ise-sxpise Capabilities(1 Pub, 1 Sub) Online (XMPP) Internal Certificate

O » steathwatch Capabilities(0 Pub, 4 Sub) Online (XMPP) ANC Certificate

Navigate back to the QRadar ISE pxGrid app ui and refresh the policy list Ul. Either create or
select the policies you want to use in your environment. Click Save.

Step 14
QRadarSettings ISESettings Policies HealthAuditLog
Policy Name List [+ T Selected Policy Name List
ANC-Destroy pxGridQRadarPortBounce
ANC-NukeFromOrbit pxGridQRadarQuarantine
ANC-Investigate ° pxGridQRadarShutDown
Save
Step 15

Validate the HealthAuditLog in the app. Notice it shows enabled as the last status. This may
take a bit to update the polling. Perhaps 1-2 min. There is Refresh and Poll now.

On clicking the refresh button, the latest status of the node will be read from the internal App Db and
updated on the table, by default the page refreshed every 5 min.

The Poll now button will send a request to the nodes to poll the status of the node.

You may now close the app window.
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QRadarSettings  ISESettings  Policies ~ HealthAuditLog

| & retresn | Lat poilnow |

ISE Node: Response Time Last Health Check Time HTTP Status Code Status
Nodel 003254079515725586 2021-05-17 23:40:34559936 200 ENABLED
Nedel 0.030228853225708008 2021-05-17 23:40:26.374261 200 ENABLED
Nodel 0030719757080076125 2021-05-17 23:3: 19 200 ENABLED
Nodel 003128218650817671 2021-05-17 23:30:34556222 200 ENABLED
Nodel 0.03184247016906738 2021-05-17 23:25:34.556597 200 ENABLED
Nedel 0031603336334228516 2021-05-17 23:2 200 ENABLED
Nodel 003490447995046575 2021-05-17 23115:34401255 200 ENABLED
Nodel 0.03083968162536621 2021-05-17 23:10:34.397889 200 ENABLED
Nedel 0.0304415223982666 2021-05-17 23:05:34397063 200 ENABLED
Nodel 0.27611494064331055 2021-05-17 23:00:34.643534 200 ENABLED

2R BEERE

Connected to ISE server Node 1,

Validate the pxGrid client on ISE:

In ISE 2.4+ On the All Clients tab, the Client Status can be Offline (XMPP). This is for
Step 16 pxGrid 1.0 and doesn’t represent any value. ISE 3.0 shows XMPP and WebSockets
Note: screens.

Admin > pxGrid Services > Web Clients (2.4+).
Step 17

Admin > pxGrid Services > Diagnostics > WebSocket (3.0) and see registered Cisco ISE
pxGrid QRadar app client.

Note: If you do not see the pxGrid registered client, ensure the ISE pxGrid QRadar app client is

using Fully Qualified Domain Name (FQDN).

e [dentity Services Engine

isca Home » Context Visibility » Operations » Paolicy ~Administration » Work Centers
» System  » Identity » Network R » Device Portal Management ~ pxGrid Services  » Feed Senvice  » Threat Centric NAC .
Click here to do visibility setup Do not show this agai
All Clients  Web Clients  Capabilities  Live Log  Settings  Certificates  Permissions
Rows/Page 2 j 1 Hn Go 2
= Refresh Y Filter-
Client Name Connect To Session Id Certificate Subscriptions Publications IP Address Status
= Qradar x j
Qradal ise se 16 CN=qgradar € topic/fcom.cisco.ise 19 18 FF

Qradar ise se:17 CN=gradar topic/com. cis 198.19.10.18 ON

se.mdm. endpoint
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You will see the client connected twice if there are two pxGrid (primary/secondary) nodes. Only
one entry for single pxGrid nodes.Assign the QRadar client to the ANC Group permissions:

Select All Clients (Admin > pxGrid Services > Client Management > Clients (ISE 3.x) > Check
the QRadar Client.

Go to Group > Add > ANC.

Step 18
Click Save.
a.
Client Group X
b.
c. Name qgradar
Groups ANC
@‘ Cancel
You should see the pxGrid client Group ANC assigned to the Cisco ISE pxGrid client,
MNote:

the below image is of ISE 3.x (above is 2.x).

Summary Client Management Diagnostics Settings
——
Clients » gradarapp
Clients
Policy Edit Cllent
Groups
Certificates
Name

qradarapp

Description

pXGrid App for Qradar

EPS

ANC

ANC =
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Help and Support Tab
Navigate to pxGrid QRadar App settings page to Help and Support tab.
This tab has two main functionalities :

1. Option to download app.log for troubleshooting by date.

2. Links to community page.

HelpandSupport

QRadarSettings ISESettings Policies HealthAuditLog

Cisco ISE pxGrid QRadar App Logs 1 February 10, 2022 - February 10, 202|§ Reset

show[10_ ¥ | entries
File Name created_at Download
applog Thu, 10 Feb 2022 00:05:01 GMT & Download
2pp-08-02-22.log Wed, 09 Feb 2022 23:55:00 GMT & Download

Showing 1 to 2 of 2 entries

- ‘ N -

Cisco ISE pxGrid QRadar App Community Links
© Latest App Updates I View detail

Product Guide @ Download here

Troublshooting Guide € Download here

Support Email @& Contact hers

e 00

Setup Indexing in QRadar

Step 1
teI?ollowing are the steps to Index CEPs in QRadar.
Step 2
* Return to the IBM QRadar Web Console.

Navigate to Admin tab, and then click Index Management.

System Configuration

Q@ €

! -':.;-"'! & T 3 a

Auto Update Backup and Recovery Global System Index Manag Aggregated Data Network Hierarchy System and License System Health
Notificati Manag Management
¢ e G @ &
X Zs : i o &
Ste System Settings Asset Profiler Custom Offense Close Store and Forward Reference Set Centralized Credentials  Forwarding Destinations Routing Rules
Configuration Reasons Management
AGIr
] 7N
O] * o0
Domain Manag Ext Manag Resource Restrictions

To setup the Indexes for use with pxGRid:
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Search for pxgrid indexes: in the upper-left corner, enter pxgrid into the search window, and
then search.

QEnable Index 0 Disable Index pxgrid

a. Sort by Property:

Indexed i Property P

pxGrid_accessService (custom)
pxGrid_adHostDomainMame (custom)
pxGrid_adHostNetBiosName (custom)
pxGrid_adHostResolvedDns (custom)
pxGrid_adHostResolvedidentities (custom)
pxGrid_adMNormalizedUser (custom)

pxGrid_adUserDomainMame (custom)

To Index the CEPs Packaged with the app, right-click on the property name, and then Enable
Index.

Recommended CEPs to be indexed are the following:

e pxGrid_adNormalizedUser
e pxGrid_auditSessionld
e pxGrid_EventName
e pxGrid_macAddress
d. e pxGrid_nasPortType
e pxGrid_src

Click Save.
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App installation on QROC
Cisco pxGrid QRadar App is certified ‘QRadar on cloud ready’ by IBM.

The following image shows data sources on your network that send information to your gateway

appliance. The gateway appliance then communicates with an instance of QRadar that is running in
the IBM cloud.

Cloud

QROC

Cisco pxGrid
App

A

Internet

Tunnelled
communication

On-Prem A Data Gateway
R Appliance

A i,
Yy

Other s
Data Sources ISE Node2

ISE Node1

The pxGrid QRadar App installation on QROC is very similar to the QRadar enterprise .

NOTE: Use the QRadar® on Cloud Self Serve app to perform administrative tasks that are related to the

provisioning and configuration of your QRadar on Cloud instance. The Self Serve app is installed on all QRadar on
Cloud Consoles by default.

Log on to the QRadar console(QROC) from a web browser to install and access Cisco ISE pxGrid QRadar
App, just as you would with QRadar deployed on your premises.

Step 1: Follow all the steps under the section “Generating the Cisco ISE pxGrid App Certificate” to
download the certificates but ensure to use the Data Gateway IP and FQDN instead of QRadar
console details.

Step 2: Follow all the steps under the section “Installing Cisco ISE pxGrid App” to install the app on
QROC.

A QRadar cloud user should ensure, that both the ISE Nodes IPs should be whitelist on data gateway.
This can be directly done in QROC Ul with the help of “Self-serve app” provided by default in QROC.
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Allowlisting an IP address
Performing the below steps should whitelist ISE server and allow communication between ISE Server
and QROC.

Users can allowlist an IP address by adding the classless inter-domain routing (CIDR) value to the Allowlist
Management page. Here user should allowlist the ISE IP here.

—_

Open the Admin settings and click QRadar on Cloud Self Serve.
Click Allowlist Management.

Click Add.

Enter the CIDR.

Click Save.

o~ N

6. Click Submit, and then click Confirm
Refer here for more details.

If the communication is still not ON, whitelist 8910 (pxGrid Service) port as well.
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Cisco ISE pxGrid App Dashboard Panels

The dashboards and panels are populated with contextual information from ISE via pxGrid. This

contextual information includes:

e Security or network admin visibility into who is connecting to the network and how they are

connecting

o Type of devices connecting to the network, how they are connecting, and the owners of

these devices

e Users’ compliance with the organization’s security policy

e Data on the incorporation of Bring Your Own Device (BYOD) security polices within the
organization and whether they include external Mobile Device Management (MDM) vendors

The dashboards and panels are designed or provide investigative insight across the entire organization
or by connection-type such as wired or wireless. These dashboards include: Passed Authentications,
Failed Authentications, Devices, Compliance, MDM, TrustSec, and Currently Assigned ANC policies.

The admin can also take ISE ANC mitigative actions on the endpoint through these all QRadar ISE
pxGrid App dashboards, except for TrustSec and Currently Assigned ANC Dashboards under ANC

Details.
Tab Name Description Search Criteria
User All Top ten users with passed Select by
auth pxGrid_adNormalizedUser
pxGrid_EventName as User
Sessions
Wired Top ten Wired users with Select by
® passed auth pxGrid_adNormalizedUser
o pxGrid_EventName as User
§ Sessions
?) pxGrid_nasPortType as Ethernet
% Wireless Top ten Wireless users with Select by
g passed auth pxGrid_adNormalizedUser
o pxGrid_EventName as User
e Sessions
o pxGrid_nasPortType as Wireless
VPN Top ten VPN users with Select by
passed auth pxGrid_adNormalizedUser
pxGrid_EventName as User
Sessions
pxGrid_nasPortType as Virtual
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Tab Name

Description

Search Criteria

WebAuth

Top ten WebAuth
(MAB+Guest) users with
passed auth

Select by pxGrid_username
pxGrid_EventName as User
Sessions
pxGrid_radiusFlowType as
wiredMAB or wirelessMAB
pxGrid_username as a valid
name, not MAC ID

Device

All

Top ten endPointProfile

Select by pxGrid_endPointProfile
pxGrid_EventName as User
Sessions

Wired

Top ten Wired
endPointProfile

Select by pxGrid_endPointProfile
pxGrid_EventName as User
Sessions

pxGrid_nasPortType as Ethernet

Wired
Dot1x

Top ten Wired Dot1x
endPointProfile

Select by pxGrid_endPointProfile
pxGrid_EventName as User
Sessions

pxGrid_nasPortType as Ethernet
pxGrid_serviceType as Framed

Wired
MAB

Top ten Wired MAB
endPointProfile

Select by pxGrid_endPointProfile
pxGrid_EventName as User
Sessions

pxGrid_nasPortType as Ethernet
pxGrid_serviceType as Call
Check

Wireless

Top ten Wireless
endPointProfile

Select by pxGrid_endPointProfile
pxGrid_EventName as User
Sessions

pxGrid_nasPortType as Wireless

Wireless
Dot1x

Top ten Wireless Dot1x
endPointProfile

- Select by
pxGrid_endPointProfile
pxGrid_EventName as User
Sessions

pxGrid_nasPortType as Wireless
pxGrid_serviceType as Framed

Wireless
MAB

Top ten Wireless MAB
endPointProfile

Select by pxGrid_endPointProfile
pxGrid_EventName as User
Sessions

pxGrid_nasPortType as Wireless
pxGrid_serviceType as Call
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Tab Name Description Search Criteria
VPN Top ten VPN Select by pxGrid_endPointProfile
endPointProfile pxGrid_EventName as User
Sessions
pxGrid_nasPortType as Virtual
WebAuth | Top ten WebAuth Select by pxGrid_endPointProfile
(MAB+Guest) pxGrid_EventName as User
endPointProfile Sessions
pxGrid_radiusFlowType as
wiredMAB or wirelessMAB
pxGrid_username as a valid
name, not MAC ID
User All Top ten users with failed Select by pxGrid_username
auth pxGrid_EventName as Radius
Failure
Wired Top ten Wired users with Select by pxGrid_username
failed auth pxGrid_EventName as Radius
Failure
pxGrid_nasPortType as Ethernet
Wireless Top ten Wireless users with Select by pxGrid_username
failed auth pxGrid_EventName as Radius
Failure
o pxGrid_nasPortType as Wireless
é VPN Top ten VPN users with Select by pxGrid_username
® failed auth pxGrid_EventName as Radius
b= Failure
g pxGrid_nasPortType as Virtual
2 WebAuth | Top ten WebAuth Select by pxGrid_username
8 (MAB+Guest) users with pxGrid_EventName as Radius
= failed auth Failure
H pxGrid_radiusFlowType as
wiredMAB or wirelessMAB
pxGrid_username as a valid
name, not MAC ID
Failure All Top ten Failure reason with Select by pxGrid_failureReason
reasons failed auth pxGrid_EventName as Radius
Failure
Wired Top ten Failure Reason for Select by pxGrid_failureReason
wired user with failed auth pxGrid_EventName as Radius
Failure
pxGrid_nasPortType as Ethernet
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Tab Name Description Search Criteria
Wireless Top ten Failure Reason for Select by pxGrid_failureReason
wireless user with failed pxGrid_EventName as Radius
auth Failure
pxGrid_nasPortType as Wireless
VPN Top ten Failure Reason for Select by pxGrid_failureReason
VPN users with failed auth pxGrid_EventName as Radius
Failure
pxGrid_nasPortType as Virtual
WebAuth | Top ten Failure Reason for Select by pxGrid_failureReason
WebAuth (MAB+Guest) with pxGrid_EventName as Radius
failed auth Failure
pxGrid_radiusFlowType as
wiredMAB or wirelessMAB
pxGrid_username as a valid
name, not MAC ID
Auth All Top ten deviceType by Select by pxGrid_deviceType
Type Failed Auth with failed auth pxGrid_EventName as Radius
Failure
Wired Top ten deviceType for Select by pxGrid_deviceType
Wired users with failed auth pxGrid_EventName as Radius
Failure
pxGrid_nasPortType as Ethernet
Wireless Top ten deviceType for Select by pxGrid_deviceType
Wireless users with failed pxGrid_EventName as Radius
auth Failure
pxGrid_nasPortType as Wireless
VPN Top ten deviceType for VPN Select by pxGrid_deviceType
users with failed auth pxGrid_EventName as Radius
Failure
pxGrid_nasPortType as Virtual
WebAuth | Top ten deviceType Select by pxGrid_deviceType
WebAuth (MAB+Guest) pxGrid_radiusFlowType as
users with failed auth wiredMAB or wirelessMAB
pxGrid_username as a valid
name, not MAC ID
Location | All Top ten locations with failed Select by pxGrid_location
auth pxGrid_EventName as Radius
Failure
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Tab Name Description Search Criteria
Wired Top ten locations of Wired = Select by pxGrid_location
users with failed auth = pxGrid_EventName as Radius
Failure
= pxGrid_nasPortType as Ethernet
Wireless Top ten locations of = Select by pxGrid_location
Wireless users with failed = pxGrid_EventName as Radius
auth Failure
= pxGrid_nasPortType as Wireless
VPN Top ten locations of VPN = Select by pxGrid_location
users with failed auth = pxGrid_EventName as Radius
Failure
= pxGrid_nasPortType as Virtual
WebAuth | Top ten location of = Select by pxGrid_location
WebAuth (MAB+Guest) » pxGrid_EventName as Radius
users with failed auth Failure
= pxGrid_radiusFlowType as
wiredMAB or wirelessMAB
= pxGrid_username as a valid
name, not MAC ID

All Top ten postureStatus = Select by pxGrid_postureStatus
Compliance
Wired Top ten postureStatus of = Select by pxGrid_postureStatus
Wired users = pxGrid_nasPortType as Ethernet
Wired Top ten postureStatus of = Select by pxGrid_postureStatus
MAB Wired MAB users = pxGrid_nasPortType as Ethernet
= pxGrid_serviceType as Call
Check
Wireless Top ten postureStatus of = Select by pxGrid_postureStatus
Wireless users = pxGrid_nasPortType as Wireless
Wireless Top ten postureStatus of = Select by pxGrid_postureStatus
MAB Wireles MAB users = pxGrid_nasPortType as Wireless
= pxGrid_serviceType as Call
Check
VPN Top ten postureStatus of = Select by pxGrid_postureStatus
VPN users = pxGrid_nasPortType as Virtual
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Tab Name Description Search Criteria
Group All Top ten ctsSecurityGroup Select by
Tag pxGrid_ctsSecurityGroup
Wired Top ten ctsSecurityGroup of Select by
Wired users pxGrid_ctsSecurityGroup
pxGrid_nasPortType as Ethernet
Wired Top ten ctsSecurityGroup of Select by
MAB Wired MAB users pxGrid_ctsSecurityGroup
pxGrid_nasPortType as Ethernet
Wireless Top ten ctsSecurityGroup of Select by
o Wireless users pxGrid_ctsSecurityGroup
% pxGrid_nasPortType as Wireless
>
= Wireless Top ten ctsSecurityGroup of Select by
MAB Wireles MAB users pxGrid_ctsSecurityGroup
pxGrid_nasPortType as Wireless
VPN Top ten ctsSecurityGroup of Select by
vpn users pxGrid_ctsSecurityGroup
pxGrid_nasPortType as Virtual
WebAuth | Top ten ctsSecurityGroup of Select by
WebAuth (MAB+Guest) pxGrid_ctsSecurityGroup
users pxGrid_radiusFlowType as
wiredMAB or wirelessMAB
pxGrid_username as a valid
name, not MAC ID
Compliance Top ten Select by
mdmComplianceStatus pxGrid_mdmComplianceStatus
pxGrid_EventName as User
g Sessions
= Registration Top ten Select by
mdmRegistrationStatus pxGrid_mdmRegistrationStatus
pxGrid_EventName as User
Sessions
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Search Functionality

The Search tab is the first tab on the page where user can enter the search details. While clicking on the
tab the search page should be displayed with a search box, dropdown to select the type of event
(Session, Radius, or both) to search, and a date-picker adjacent.

When the user enters text in the search box and clicks the Search’ button, the date field should be
populated with the existing date range from the application window by default. The end users should be
able to change its according to their needs. If the search returns more than 200 (TBD) records the user
should get an acknowledgement saying "This search returns too many records" and displaying the first
200 records. In such cases, the user should narrow down their search by using the event type filter and
the minimum time span.

In the search window, the user should be able to enter IP Address, MAC Address and Session ID. When
the user clicks the search button, the results should be displayed in a tabular format with pagination. The
result’s displayed format will be same as the current window displayed with details while clicking on the
existing graph in dashboard.

There should be an option (hyperlink) provided at the end of the table to view the raw event associated
with the selected event. The request data from the Ul should be validated for security and valid request
format.

Log Activity Network Activity — Assets FReports  Admin Pre-Vsiiciafion Gisco ISE puGrid

2020-09-02 14:27 - 2020-09-03 14:27

Search Passed Authentications Failed Authentications Devices Compliance Trustsece MDM  ANC Details

= Session ~ September 2, 2020 14:27 - September 3, 2020 14:27 m

Search Result: Search criteria return more records. The first 200 records are displayed. m
Dev Time “  IP Address State MAC Address Username Calling Station ID Called StationlD NAS IP Address Raw Data
02-Sep-2020 09:12:19.587 GMT+5:30 182.168.1.254 STARTED 20:A6:CDiCO:D9:00 20:AG:CD:CODO:00 20:A6:CDiCO:D9:00 CO6T:AFAZGETT 192.168.0.217 View Raw Details
02-Sep-2020 09:12:26.564 GMT+5:30 182.168.1.128 STARTED 20:A6:C0DiC9:D9:00 20:AGCDICD9:00 20:A6:C0DiC9:D9:00 CO:6T:AFABGETT 192.168.0.217 View Raw Details
02-Sep-2020 09:12:41.085 GMT+5:30 10.235.24.6 STARTED 02:8F:A5:TE:C:IBA 02:8FASTEQC:BA 02:8F:A5:TE:9C:BA CO:6T:AFABGETT 192.168.0.217 View Raw Details
02-Sep-2020 09:12:49.602 GMT+5:30 182.168.1.254 STARTED 20:A6:CDiCO:D9:00 20:AGCDICOD9:00 20:A0:C0DiCO:D9:00 CO:6T:AFAZGETT 192.168.0.217 View Raw Details
02-5ep-2020 09:12:54.749 GMT+5:30 192.168.0.42 STARTED 02:8FRASTESCEA 02:8FA5TESCEA 02:8FASTESCBA COBT:AFASIBETT 192.168.0.217 View Raw Details
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Event: Raw Data

Aug 25 17:12:39 192.168.0.227 LEEF:2.0|CISCO|QRadarAppForPxGrid|1.0|User Sessions|*|
srcMac=20:A6:CD:C3:D9:00 providers=[udaposNone&apos] naslpAddress=192.168.0.217
mdmCompliant=False src=192.168.1.254 radiusFlowType=WiredMAB identitySourcePortEnd=0
endpointCheckResult=none callingStationld=20:A6:CD:C9:09:00 ssid=C0-67-AF-A8-6E-11
endpointProfile=Unknown mdmPinLocked=False state=STARTED networkDeviceProfileName=Cisco

identitySourcePortFirst=0 mdmJailBroken=False nasPortType=Ethernet
adNormalizedUser=20:A6:CD:C9:D02:00 auditSessionld=C0A800D20000005301983784
calledStationld=C0:67:AF:A8:6E:11 serviceType=Framed nasPortld=GigabitEthernet1,+ devTime=2020-
08-25T17:12:04.457Z identitySourcePortStart=0 usrName=20:A6:CD:C%:D9:00 mdmRegistered=False
mdmDiskEncrypted=False

Accepted Search format:

IP Address XX X. X
MAC Address  X:X:X:X
Session ID XXXX

Partial Search Criteria:
IP Address should begin with X.
Mac Address should begin with X:

Accepted Wildcard characters:

Wildcard Description Example

Character

* Matches a string of zero or more ***¥*192.*,192.168.*.*, AE:BC:*
characters

? Matches any single character 192.77?.77.77,192.168.7?.124,DE:??:DF:*
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Passed Authentications

The Passed Authentications dashboard view provides visibility into successful machine and user
authentications across an organization and by wired and wireless connection type. This provides the
admin with a view of how employees are connecting to the network, are they connecting over Wired,
Wireless, VPN or Guest and where are they connecting from. This information is obtained from the
Cisco ISE pxGrid App pxGrid client subscribing to the Session Directory topic.

The admin drills down on the user or host and obtains the following contextual information: endpoint
device information, MAC Address, IP Address, posture status, NAS Port Type, NAS Port ID, NAS
Identifier, NAS IP Address, WLAN Information, Calling Station ID, Called Station ID, AD resolvable user
and host identities.

The AD resolvable user and host identities provide a consistent name format when different EAP
methods are used, for example, EAP Chaining.

For the WebAuth (guest & employee access) portion we show the credentialed authentication flow.
We don’t show Hotspot (basic MAB).

Note:  Some fields for WebAuth may not agply as they’re using Guest users.
Il

Step 1 Go to Cisco ISE px > Passed Authentications.

= IBEM QRadar

Ofises  LogAdiviy  NetwokAdhity  Assels  Reports  Admin  Cisoo ISE peGid

Passed Authentications  Failed Authentications Compliance Trustsec MDM  ANC Details

All Wired

10

2 10 - " 2 -
. - - - - - : . . : . . . - . -
& o g & o o 2 o e & £ & o o L
. s S I i S

& P 2
& Nl

Cisco Systems © 2021 Page 43



SECURE ACCESS HOW-TO GUIDES

Wireless

WebAuth

Step 2

jabez.

VPN

pgupta3

1 1

pguptad
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Select an end-user, this provides a tabular view of the following contextual information:

Data For : ScaleUser7

Show entries
Dev Time “ IPAddress  State MAC Address
06-1ul-2021 0946:19.274 GMT=5:30 | 21.00.15 STARTED | 95:7028:£400:06
06-Jul-2021 09:46:19.274 GMT+5:30 | 21.0.0.15 STARTED = 95:70:2B:£4:00:06

4

Showing 1 to 2 of 2 entries

The Endpoint Profile, Endpoint Operating System,

Username

ScaleUserT

ScaleUser7

Calling Station ID

95:70:2B:E4:00:06

95:70:28:£4:00:06

the endpoint information for the user.

Data For : ScaleUser7

Show entries

atus  Endpoint Profile | Endpoint Operating System ~ Group D AD Normalized User
Unknown Nane None SealeUser?
Unknown Nane Nane SealeUser7

Ll

Showing 1 to 2 of 2 entries

AD Host Domain Name

None

None

Called StationlD

None

None

None

None

NAS IP Address

1114

111

AD Host NetBios Name

None

MNone

NAS Port ID

GigabitEthernet! ]

GigabitEthernet! T

x
EXPORT
NAS Port Type NAS Identifier Posture Statu
Etnernet Mone None
Ethernet None None

3

Previous \j Next

and the AD Normalized User Name provide

EXPORT

AD Host Resolved Identities AD Host Resolved DNS AD User Domain N:

None None

Nene None

r

Previous E Next
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The AD user Resolved ldentities and AD User Resolved DNS provide the consistent identities

of the end user.

AD User Domain Name
dcloud.cisco.com
dcloud.cisco.com
dcloud.cisco.com

dcloud.cisco.com

AD User Net Bios Name

DCLOUD

DCLOUD

DCLOUD

DCLOUD

AD User Resolved ldentities

doctor@dcloud.cisco.com

doctor@dcloud.cisco.com

doctor@dcloud.cisco.com

doctor@dcloud.cisco.com

AD User Resolved DNS

CN=Doctor,QU=Demo Users,DC=ddoud,DC=cisco,DC=com

CN=Doctor.OU=Demo Users,DC=ddoud,DC=cisco,DC=com

CN=Doctor,QU=Demo Users,DC=ddoud,DC=cisco,DC=com

CN=Doctor.QU=Demo Users,DC=ddoud.DC=cisco.DC=com

The Is Machine Authentication attribute determines if this is machine authentication or user
authentication. If this attribute is set to "true", then this is machine authentication, if this is set
to "false", then this is user authentication.

Data For : ScaleUser7

Show [10_ v entries
D User Resolved DNS ~ Terminal Server Agent ID

None

None

4

Showing 1 to 2 of 2 entries

Is Machine Authentication
None None

None None

Service Type

Tunnel Private Group ID

None None

None None

Airespace WLAN 1D

X
EXPORT
Network Device Profile Name Radius Flow Type ssID ANC Policy
Cisco None None Mone
Cisco None None Mone

Previous Next
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Devices

The Devices Dashboard View provides the admin with visibility into the connected devices across the
organization or by wired and wireless connection types. An organization may have a security policy
about recommended or non-recommended devices for employees. The admin is able to drill down
and see the owners of these devices and their location. This information is obtained from the Cisco ISE
pxGrid App client subscribing to the Session Directory topic.

The admin drills down on the endpoint profile and obtains the following contextual information:
endpoint device information, MAC Address, IP Address, posture status, NAS Port Type, NAS Port ID,
NAS Identifier, NAS IP Address, WLAN Information, Calling Station ID, Called Station ID, AD resolvable
user and host identities.

The AD resolvable user and host identities provide a consistent name format when different EAP
methods are used, for example, EAP Chaining.

Go to Cisco ISE pxGrid > Passed Authentications > Devices.

Step 1 Select EndProfile (All) > Microsoft-Workstation.

Step 2
= IBM QRadar L'l 2

Dashboard ~ Ofienses  LopActviy  MetworkActhity  Asses  Repors Admin Syste Tume: 11:01 pm

ciseo Passed Authentications
2C0

BEirD
All Wired
Wired  Wired Dot1x  Wired MAB
150
100
10
20
a0
50
40
[ — e . 2 :
W Sl e a2 S
Aruba-Device Cisco-Switch
Wireless VBN

Wireless ~ Wireless Dot1x  Wireless MAB

8

]
2 2 2 2 2
2
]
+ 1 1
E] 3 1
2 i ‘ . .
- - - o
pcrasot el PE oo oWt Um0 e D DO oot

Unknown Samsung-Devi... Linux-WWorkst... Microsoft-Wo... OneFlus-Devi..
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The Username, IP address and MAC address attributes are associated with the device.

The NAS IP, NAS Port ID and NAS Port Type attributes contain the connection type information.

System Tame: 1104 p

EDDiST

show [10_w | entries
Dev Time “ IP Address State MAC Address Username Calling Station ID
06-Jan-2020 03:03:28.367 GMT+3:30  192.168.0.44 DISCONMECTED  4CiBB:S&SEDDET  4CEE:SS3SEDDET 4CiBB:3E:
06-Jan-202( 753 GMT+5:30 192.168.0.56 DISCONNECTED = 28:C6:3F:C4:61:93 28:C6:3FC4:61:93 28:C6:3F:C4:61:93
06-Jan-2020 03:03:31.281 GMT+5:30  192.168.0.94 DISCONMECTED ~ FEFC:16:61:D7:98 FE:FC:16:61:D7:98
06-Jan-. 23.510 GMT+5:30 192.168.0.212 STARTED EB:BA:64:03:B3:E4 EB:BA 3B3E4
08-Jan-2020 03:07:23.510 GMT+5:30  192.168.0.212  STARTED EB:6A:64:03:63:E4 E5:6A:64:03:B3:E4 EB:BA:64:03:83:E4

Called StationlD

CO:E6T:AFABBET

CO:6T:AF:AB:6E:11 192.168.0.217 GigabitEthernet1,
COET-ARAREETT 192.168.0.217 GigabitEthernet1,
CO:67:AF:AB6ET1 192.168.0.217 GigabitEthernet1, +

CO:BT:AFABBE11

MNAS IP Address

192,166.0.217

192.168.0.217

NAS Port 1D

GigabitEthemnet1 +

GigabitEthemett. +

NAS Port Type
Ethernet
Ethernet
Ethernet
Ethernet

Ethernet

NAS Identifier
None
None
None
None

None

The NAS Identifier attribute may contain more information about the device such as the MAC address.
The EndPoint Profile and Endpoint Operating System attributes provide the type of device and operating

system.

Data For : Microsoft-Workstation

Show entries
Posture Status
None
None
None
None

Mone

Endpoint Profile

Microsoft-Workstation

Microsoft-Workstation

Microsoft-Workstation

Microsoft-Workstation

Microsoft-Workstation

Endpoint Operating System
Microsoft Windows
Microsoft Windows Server 200
Microseft Windows Longhomn
Microsoft Windows Longhorn

Microseft Windows

Vista, Windows 7 SP1, or Windows 8.1 Update 1

8 or 2008 Beta 3 (accuracy 93%)

(accuracy 94%)
(accuracy 93%)

Longhomn (accuracy 95%)

Group 1D

Nene

None

None

None

Neone

AD Normalized User

4CBE:S8:3E0D:ET

28:C6:3R:C4:61:93

FE:FC:16:61:07:95

ES:6A64:03:B3:E4

ES:BA:6403:BIE4

AD Host Domain Name

None

None

None

None

None

AD Host NetBios Name

Nene

None

None

None

Nene

®

AD Host Resolve
Mene
None
Mone
MNone

Mone

The AD Username/Host and AD Resolved Username/Host identity attributes provide a consistent way

of providing the username and hostname despite various EAP authentication types.
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Data For : Microsoft-Workstation

Show entries
AD Host Resolved DNS
Mone
Mone
Mone
Mone

Mone

The Is Machine Authentication attribute if set to "true" denotes that this is

AD User Domain Name

None

None

None

None

None

AD User Net Bios Name

Mone

Mone

Mone

Mone

Mone

AD User Resolved Identities

Mone

Mone

Mone

Mone

Mone

is set to "false", it denotes user authentication.

Data For : Microsoft-Workstation

Show entries

«d DNS Terminal Server Agent ID

None

None

None

None

None

Is Machine Authentication Service Type
Nene Framed
None Framed
None Framed
Neone Framed
Neone Framed

Tunnel Private Group ID

Nene

None

None

Nene

Nene

AD User Resolved DNS

Mone

Mone

Mone

Mone

Mone

Airespace WLAN 1D

Nene

None

None

None

None

Terminal Server Agent ID

Mone

Mone

Mone

Mone

Mone

None

None

None

None

None

Is Machine Authentication

Framed

Framed

Framed

Framed

Framed

Service Type

Tunnel Pric
Mone
Mone
Mone
Mone

Mone

machine authentication. If it

Network Device Profile Name Radius Flow Type
Cisco WiredMAE
Cisco WiredMAE
Cisco WiredMAE
Ciscor WiredMAE
Ciscor WiredMAE
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CO-67-AF-A8-6E-11

CO-67-AF-AB-6E-11

CO-67-AF-AB-6E-11

CO-67-AF-AB-6E-11

CO-67-AF-AB-6E-11

ANC Policy

None

None

None

None

None
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Failed Authentications

The Failed Authentications dashboard view provides visibility into failed authentication attempts across
the organization and by wired and wireless connection types. This provides the admin with a view of
how these failed authentications occur with panel breakdowns by user, failure reason, device type,
and location. This information is obtained from the Cisco ISE pxGrid client App subscribing to the
RADIUS failure topic.

The user panel provides a breakdown by user and provides the following contextual information:
failure reason, device type, location, endpoint device information, MAC address, IP Address, posture
status, NAS IP address, NAS Port Type, NAS Port ID, WLAN information, NAS Identifier, Calling Station
ID, Called Station ID, access, identity store, and credit check.

The other panels provide a breakdown by failure reason, device type and location, and provide the
admin insight to how these failed authentications occur. The same contextual information from the
user panel is available in these panel breakdowns.

The AD resolvable user and host identities provide a consistent name format when different EAP
methods are used, for example, EAP Chaining.

User Panel

The user panel provides a breakdown by username.
Step 1

Go to Cisco ISE pxGrid > Failed Authentications.

=  IBMOQRadar 0 9

Dashboard  Ofienses  LopActvity  MetworkActhity  Assets  Repors  Admin CiscolSE pGrd System Tame: 1110 pm

ations  Failed Authentications Compliance Trustsec MDM  ANC Details Reset

i
cisco

User Failure Reason

All - wired Wireless VPN Guest User Al wired Wireless VPN  Guest User

Step 2 :I
Step 3 o 8 R K R B B B §

Go to Cisco ISE pxGrid > Failed Authentications > User > ScaleUser7.

The IP Address, Failure Reason, Username attributes provide information into failed
authentication attempts.
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Data For : ScaleUser7 X

Show entries
D . Dev Time IP Address Failure Reason Username Server Name Authentication Protocol Device Type Location Calling Station 1D
16196328 12-May-. 5. GMT+5:30 21.0.07 22040 Wrong password or invalid shared secret ~ ScaleUser7 ciscoisepripsn PAP_ASCII All Devis All Locations
16196328370 12-May-. 681 GMT+5:30 21.0.07 22040 Wrong password or invalid shared secret  ScaleUser7 ciscoisepripsn PAP_ASCI All Device Types Al Locations
1619632837049948 12-May-2021 05:51:20.159 GMT+5:30 21.0.07 22040 Wrong password or invalid shared secret  ScaleUser7 ciscoisepripsn PAP_ASCH All Device Types Al Locations
1619632837049948 12-May-2021 05:51:20.159 GMT+5:30  21.0.07 22040 Wrong password or invalid shared secret ScaleUser? ciscoisepripsn PAR_ASCH All Device Types All Locations 95:70:28:E4:00:06

»

Previous Next

The Server Name, Authentication Protocol, Device Type, Location, Calling Station ID, NAS IP Address,
NAS Port ID, NAS Port Type attributes provide more authentication details and location information of
failed authentication attempts.

Showing 1to 4 of 4 entries

Data For : ScaleUser7 x

 ovorr |

Show entries

NAS IP Address NAS Port 1D MAS Port Type MAC Address Message Code User Type Access Service Identity Store Authentication Method Service Type Credential Check AD Non
1.1.1 GigabitEthernet1, 7] Ethemnet None 5400 User Default Network Access Internal Users PAP_ASCII None PAP_ASCI None
1.1.1 GigabitEthernet1 ] Ethemnet None 5400 User Default Network Access nternal Users PAP_ASCII None PAP_ASCI None
1.1.1 GigabitEthernet1, 7] Ethernet None 5400 User Defauit Network Access nternal Users PAP_ASCII None PAP_ASCI None
111 GigabitEthernet1,7] Ethernet None 3400 User Default Network Access nternal Users PAP_ASCII None PAP_ASCI None

»r

Previous MNext

Showing 1 to 4 of 4 entries

The Access Service attribute provide the ISE allowed protocol rules, the Identity Store attribute
provides the back-end credential database of the end-user in question.

The Authentication Method attribute provides the ISE authentication rule, and the Credit Check
attribute provides the EAP authentication method.

Data For : ScaleUser7 X

(=]

AD User Resolved DNS

Show entries

AD Host Domain Name AD Host NetBios Name AD Host Resolved Identities AD Host Resolved DNS AD User Domain Name AD User Net Bios Name AD User Resclved Identities

Mone Nene

Mone Nene None Nene Nene Mone
Mone Nene Mone Nene None Nene Nene Mone
Mone Nene Mone Nene None Nene Nene Mone
Mone Nene Mone Nene None Nene Nene Mone

Fl

Showing 1to 4 of 4 entries

Previous Next

The AD Host/User Resolved Identities, AD Host/User Resolved DNS, AD User Domain, AD User Net
BIOS Name Host attributes in the screenshots provide additional context around the host and user

identities.
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Failure Reason Panel

The Failure Reason panel provides a breakdown by failure reason.

Go to Cisco ISE pxGrid > Failed Authentications.

Select Failure Reason > 24408 User authentication against Active Directory failed since user has
entered the wrong password.

IBM QRadar

Offonses  LogAdiiity  MetworkAdiity  Asses  Repos  Admin  Cisco ISE piGod

= Failed Authentications Co

User Failure Reason
Al Wired Wireless VPN Guest User Al Wired Wireless VPN Guest User
22
20
10
4 4 4 4 4 4 4 4 4
B . e b o A - 22040 Wrong password... (22]
e ¥ o 2 2% 25 e o B

The IP Address, Calling Station ID, Username attributes provide basic information for end users
associated with failure reasons.

Data For : 22040 Wrong password or invalid shared secret =
-
Show entries
Dev Time . IP Address Failure Reason Username Server Name Authentication Protocol Device Type Location Calling Station ID
12-May-2021 04:12:45.480 GMT+5:30 21.0.0.1 22040 Wrong password or invalid shared secret  ScaleUser1 ciscoisepripsn PAP_ASCII All Device Types ~ All Locations = 95:70:2B:E4:00:00

:112:45.505 GMT+5:30  21.0.0.2 22040 Wrong password

12-May-. or invalid shared secret  ScaleUser2 ciscoisepripsn PAP_ASCII All Device Types ~ All Locations

12-May-. 112:45.529 GMT+530  21.0.03 22040 Wrong password or invalid shared secret ~ ScaleUser3 ciscoisepripsn PAP_ASCII All Device Types ~ All Locations

The Server Name, Authentication Protocol, Device Type, Location, Calling Station ID, NAS IP Address,
NAS Port ID, NAS Port Type attributes provide more authentication details and location information of

failed authentication attempts.
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Data For : 22040 Wrong password or invalid shared secret =
Show entries
MAS IP Address MAS Port ID MNAS Port Type MAC Address Message Code User Type Access Service Identity Store Authentication Method Service Type Credential Check AD Norm
1.1.1.1 GigabitEthernet1 7] Ethernet MNone 3400 User Default Metwork Access nternal Users PAP_ASCII None PAP_ASCII None
1.1.1.1 GigabitEthernet1 7] Ethemnet MNone 3400 User Default Metwork Access nternal Users PAP_ASCII None PAP_ASCII None
1.1.1.1 GigabitEthernet1 7] Ethemnet MNone 3400 User Default Metwork Access nternal Users PAP_ASCII None PAP_ASCII None
1111 GigabitEthernet1, 7] Ethemnet MNone 3400 User Default Metwork Access nternal Users PAP_ASCII None PAP_ASCII None

The Access Service attribute provides the ISE allowed protocol rules, the Identity Store attribute
provides the back-end credential database of the needed end user.

The Authentication Method attribute provides the ISE authentication rule, and the Credit Check attribute
provides the EAP authentication method.

Data For : 22040 Wrong password or invalid shared secret X

L ovor |

AD User Resolved DNS

Show [10_w |entries

AD Host Domain Name AD Host NetBios Name AD Host Resolved Identities AD Host Resolved DN5 AD User Domain Name AD User Net Bios Name AD User Resolved Identities

None None None None MNone None None MNone
None None None None MNone None Nene MNene
Nene Nene Nene Nene Mone Nene Mone Mone
Nene Nene Nene Nene Mone Nene Mone Mone

The AD Host/User Resolved Identities, AD Host/User Resolved DNS, AD User Domain, AD User Net
BIOS Name Host attributes in the images provide additional context around the host and user identities.

Auth Type Panel

The Auth Type attribute categorizes the NAD device for Network Device Groups that may distinguish

by different locations. For example, you may have Cisco Catalysts switches for the North America
SRokations.

Step 2
To categorize device type:

Go to Cisco ISE pxGrid > Failed Authentications.

Select Device Type > All Device Types.

User Failure Reason

Al wired Wireless VPN WebAuth Al wired  Wireless VPN
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100

60

40

All Devics Types (28]

All Location...

The IP Address, Calling Station ID, and Username attributes provide basic information for end users
associated with failure reasons.

Data For : All Device Types "
Show entries
[[v] * Dev Time IP Address Failure Reason Username Server Name Authentication Protocol Device Type Location Calling Station ID
1619632837049942 12-May-2021 05:51:20.003 GMT+5:30  21.0.0.1 22040 Wrong password or invalid shared secret ~ ScaleUser1 ciscoisepripsn PAP_ASCII All Device Types  All Locations 95:70:28:E4:00:00
1619632837049943 12-May-2021 05:51:20.035 GMT+5:30 21.0.0.2 22040 Wrong password or invalid shared secret ~ ScaleUser2 ciscoisepripsn PAP_ASCH All Device Types Al Locations 95:70:28:E4:00:01

The Server Name, Authentication Protocol, Device Type, Location, Calling Station ID, NAS IP Address,
NAS Port ID, and NAS Port Type attributes provide more authentication details and location information
of failed authentication attempts.

Data For : All Device Types X
Show entries
NAS IP Address NAS Port ID NAS Port Type MAC Address Message Code User Type Access Service Identity Store Authentication Method Service Type Credential Check AD Norm
1111 GigabitEthernet1, 7 Ethemnet None 5400 User Default Network Access nternal Users PAP_ASCH None PAP_ASCH Nene
1.1.11 GigabitEthemet1,7J Ethernet MNone 5400 User Default Network Access nternal Users PAP_ASCI None PAR_ASCI None
111 GigabitEthernet1, ] Ethernet MNone 5400 User Default Network Access nternal Users PAR_ASCH None PAP_ASCI None

The Access Service attribute provides the ISE allowed protocol rules, the Identity Store attribute
provides the back-end credential database of the needed end user.

The Authentication Method attribute provides the ISE authentication rule, and the Credit Check
attribute provides the EAP authentication method.

Data For : All Device Types *
Show [10 w | entries
AD Host Domain Name AD Host NetBios Name AD Host Resolved Identities AD Host Resolved DNS AD User Domain Name AD User Net Bios Name AD User Resolved Identities AD User Resolved DNS
Nene None None None None None None None
Mone Mone Mone Mone None Mone Nene Mone
Bans Bane Mans Bane Nons Mans Nons Klons
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The AD Host/User Resolved Identities, AD Host/User Resolved DNS, AD User Domain, AD User Net
BIOS Name Host attributes in the screenshot provides additional context around the host and user

identities.
Locations Panel

The location panel provides insight into attempted by failures by NAD location type and provides a
drill-down based on Locations.

Go to Cisco ISE pxGrid > Failed Authentications.

Go to Location > All > All Location.

Ste|
User Failure Reason
Ste|
Al Wired Wireless VPN WebAuth Al Wired Wireless VPN WebAuth
100
20
60
40

All Device Types (28)

All Location.

The IP Address, Calling Station ID, Username attributes provide basic information for end users
associated with failure reasons.

Data For : All Locations

Show entries
] - Dev Time IP Address Failure Reason Username Server Name Authentication Protocol Device Type Location Calling Station ID
1619632837049798 12-May-2021 04:12:45.480 GMT+5:30 21.0.0.1 22040 Wrong password or invalid shared secret ScaleUser1 ciscoisepripsn PAP_ASCH All Device Types ~ All Locations  95:70:2B:E4:00:00
161963283 12-May-20. 2:45.505 GMT+5:30 21.0.0.2 22040 Wrong password or invalid shared secret ScaleUser2 ciscoisepripsn PAP_ASCH All Device Types Al Locations

1619632837049800 12-May-2021 04:12:45.529 GMT+5:30 21.0.0.3 22040 Wrong password or invalid shared secret ScaleUser3 ciscoisepripsn PAP_ASCII All Device Types ~ All Locations = 95:70:2B:E4:00:02

The Server Name, Authentication Protocol, Device Type, Location, Calling Station ID, NAS IP Address,
NAS Port ID, NAS Port Type attributes provide more authentication details and location information of
failed authentication attempts.
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Data For : All Locations i
Show entries

NAS IP Address NAS Port ID NAS Port Type MAC Address Message Code User Type Access Service Identity Store Authentication Method Service Type Credential Check AD Norm;
1.1.11 GigabitEthemet1 7] Ethernet None 5400 User Default Network Access nternal Users PAP_ASCII None PAP_ASCII Nene
1114 GigabitEthemet1 7] Ethernet None 3400 User Default Network Access nternal Users PAP_ASCI None PAR_ASCI None
111 GigabitEthemnet1, 7] Ethernet None 5400 User Default Metwork Access nternal Users PAR_ASCI None PAP_ASCH Nene

The AD Host/User Resolved Identities, AD Host/User Resolved DNS, AD User Domain, and AD User Net

BIOS Name Host attributes in the following screenshots provide additional context around the host and
user identities.

Data For : All Locations =
Show entries
AD Host Domain Name AD Host NetBios Name AD Host Resolved Identities AD Host Resolved DNS AD User Domain Name AD User Net Bios Name AD User Resolved Identities AD User Resclved DNS
Mone Mone Meone Mone Mone None Mone Mone
Mone Mone Mone Mone Mone None Mone Mone
Mone Mone Mone Mone Mone None Mone Mone
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Compliance

The Compliance Dashboard provides the admin with ISE posture compliant or non-compliant devices
across the organization or by wired or wireless connection type. The organization may have security
policy for their employees such as ensuring that AV DAT files are up-to-date and AV services must be
running for compliance. If either of these are not the case, then the end user is deemed non-
compliance.

Go to Cisco pxGrid > Compliance (All).

Go to Compliant.

=  IBMQRadar o 9

Dashiboad  Offenses  LogAmtvity  MetworkAdfivity  Asses  Repos  Admin  Cisco ISE pxGnd Systen Time: 11:26 pm

i - q
‘.I‘. p ‘ Compliance
CISC

Compliance (All) Compliance (Wired)

Wired  Wired MAB

10

Active cisSe..

Compliance (Wireless) Compliance (VPN)

Wireless  Wireless MAB

B
3
. 2 2 2
1 1
1 1
| -
M
e naciive cfs... nactive cts.. Active ctsSe.. v

Active cisSe. Active cisSe.. o o o
Active ctsSe... Active ctsSe... Active ctsSe.

You will see a list of compliant end users along with the associated contextual information.

The IP address, MAC address, Username, Calling Station ID and Posture Status attributes provide the
basic user information. The NAS Port ID, NAS Port Type, NAS IP Address attributes contain the
location and connection-type information. The State attribute determines the Postured Status.
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Data For : Compliant X
Show| 10 % entries
Dev Time “ IP Address State MAC Address Username Calling Station ID Called StationID NAS IP Address NAS Port ID NAS Po
18-Feb-2018 10:17:19.596 EST  192.168.1.15 POSTURED  00:50:56:86:BB:13  pxgrid1 00:50:56:86:BB:13 50:3D:E5:C4:05:8B 192.168.1.3 GigabitEthernet1/0/11  Ethernet
18-Feb-2018 10:17:19.5696 EST ~ 192.168.1.15  POSTURED  00:50:56:86:BB:13  pxgrid1 00:50:56:86:BB:13  50:3D:E5:C4:05:8B  192.168.1.3 GigabitEthernet1/0/11  Ethernet
18-Feb-2018 10:17:23.5633 EST ~ 192168115  STARTED 00:50:56:86:BB:13  pxgrid1 00:50:56:86:BB:13  50:3D:E5:C4:05:8B  192.168.1.3 GigabitEthernet1/0/11  Ethernet
The Posture Status attribute contains the value of the posture status, compliant, non-compliance, and
pending.
The Endpoint Profile attribute is the device information of the end user along with the Endpoint
Operating System attribute.
NAS Identifier Posture Status Endpoint Profile Endpoint Operating System Group ID AD Normalized User AD Host Domain Name
Compliant Windows7-Workstation ~ Windows 7 pxgrid1
Compliant Microsoft-Workstation Windows 7 Professional 64-bit pxgrid1
Compliant Microsoft-Workstation Windows 7 Professional 64-bit pxgrid1

The AD Username/Host and AD Resolved Username/Host identity attributes provide a consistent way
of providing the username and hostname despite various EAP authentication types.

AD Host NetBios Name AD Host Resolved Identities AD Host Resolved DNS AD User Domain Name AD User Net Bios Name AD User Resolved Identities

WIN7-PC3$@Ilab10.com LAB10 pxGrid1@lab10.com
WIN7-PC3$@Ilab10.com LAB10 pxGrid1@lab10.com
WIN7-PC3$@lab10.com LAB10 pxGrid1@lab10.com

The Is Machine Authentication attribute if set to "true" denotes that this is machine authentication. If
set to "false" denotes user authentication.

AD User Resolved DNS Terminal Server Agent ID Is Machine Authentication Service Type Tunnel Private Group 1D Airespace WLAN ID
CN-nxOnd’,CN~u'.ms,(_ false Framed
faise Framed
false Framed
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TrustSec

The TrustSec dashboard contains the Security Group Tag (SGT) Information for assigned end users.
This provides the admin with visibility to see which end user is associated with a SGT. For example, a
SGT of Quarantined Systems, will provide a view of end users who have been assigned this label.

Go to Cisco ISE pxGrid > Trustsec.
Select Group Tag (All.)

Select Quarantined Systems.

IBM QRadar

Offenses  LogAdiivity  MebworkAcihity  Asssls  Reports

Group Tag (All) Group Tag (Wired)

Wired  Wired MAB

08

08

04

isenode1

Group Tag (Wireless) Group Tag (VPN)

Wireless  Wireless MAB

3
| I .
0

isenods2 isenoda1 isenodes isenodes isenoded

1 1

isenodel senoded sencde?

This provides the end-user information associated with the SGT. Here we see the Username, IP
Address, and MAC Address attributes. We also see the NAS IP Address, NAS Port ID, and NAS Port
type attributes to determine the location and connection type.

Dev Time “ IP Address State MAC Address Username Calling Station ID Called StationID NAS IP Address NAS Port ID
22-Feb-2018 04:42:41.022 EST  192.168.1.37 STARTED 00:0C:29:C1:7B:2C  LAB10\pxgrid2  00:0C:29:C1:7B:2C 50:3D:E5:C4:05:8B  192.168.1.3 GigabitEthernet1/0/11
22-Feb-2018 04:59:19.938 EST  192.168.1.37 DISCONNECTED  00:0C:29:C1:7B:2C  LAB10\pxgrid2 = 00:0C:29:C1:7B:2C 50:3D:E5:C4:05:8B  192.168.1.3 GigabitEthernet1/0/11
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This also provides the Endpoint Profile, Endpoint Operating System and AD normalized user/host names
and AD user/host FQDN identities attributes.

NAS Port Type NAS Identifier Posture Status Endpoint Profile dpoint Operating Sy 1 Group ID AD Normalized User AD Host Domain Name
Ethernet Windows7-Workstation ~ Windows 7 Professional pxgrid2
Ethernet Windows7-Workstation ~ Windows 7 Professional pxgrid2

The AD Username/Host and AD Resolved Username/Host identity attributes provide a consistent way
of providing the username and hostname despite various EAP authentication types.

AD Host NetBios Name AD Host Resolved Identities AD Host Resolved DNS AD User Domain Name AD User Net Bios Name AD User Resolved identities
PXGRID2-PCSE LAB?Y
PXGRID2-PCSE LABI0

The Is Machine Authentication attribute if set to "true" denotes that this is machine authentication. If set
to "false" denotes user authentication.

o

w

w

Terminal Server Agent ID Is Machine Authentication Service Type Tunnel Private Group ID Airespace WLAN ID Network Device Profile Name
false Framed Cisco
false Framed Cisco
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Mobile Device Management (MDM)

The MDM Dashboard provides the admin with the visibility to look into an organizations MDM security
policy. In the ISE 2.4 initial release, only the registration and compliance status are available.

Go to Cisco ISE pxGrid > MDM.

Select Compliance.

IBM QRadar Security Intelligence

Dashboard Offenses LogActivity Network Activity Assets Reports Admin NELLINIFSTch ]

2018-02-16 21:32 - 2018-02-22 21:32

Passed Authentications Failed Authentications Devices Compliance Trustsec MDM ANC Details

Compliance Registration

True (19) | True (19) |

\

" v

\ X

\ False (286) \ Faise (286)

The Username, MAC Address, IP Address and Registration and Compliance Status attribute are
Nota'vai'hibiaésumed that MDM is already configured in ISE. In this example, Cisco Meraki is used.

Username *  MAC Address IP Address MDM MAC Address 0OS Version i ion Status C i Status Model Manufacturer uDID Serial Nur
pxgrid1 88:CB:87:ED:45:DA  192.168.1.11 True True
pxgrid1 88:CB:87:ED:45:DA  192.168.1.11 True True

Cisco Systems © 2020 Page 60



SECURE ACCESS HOW-TO GUIDES ciISCO

ANC Details

The ANC Details Dashboard View provides visibility into the ANC policies currently assigned to
endpoints MAC address.

Go to Cisco ISE pxGrid > ANC Details.

IBM QRadar Security Intelligence

Dashboard Offenses LogActivity Network Activity Assets Reports Admin ReEELEN F0 (el System Time: 9:4

2018-02-16 21:50 - 2018-02-22 21:50 [l
Ste|

Passed Authentications Failed Authentications Devices Compliance Trustsec MDM ANC Details

Currently Assigned ANC policy

Show| 10 %|entries

Mac Address *  Policy Name

00:0C:29:C1:7B:2C pxGridQRadarQuarantine
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Configuring Cisco ISE Adaptive Network Control Policies

Cisco ISE Adaptive Network Control (ANC) Policies provide a means of enforcing an organization’s
security policy by issuing a quarantine, port-bounce, or port-shut on the endpoint. When an endpoint
is quarantined, this issues a Change of Authorization (CoA) and the endpoint is quarantined due to the
organization’s security policy. The security policy may be just to monitor the traffic and take no action.
In this case, a Security Group Tag (SGT) can be assigned. SGT are part of the Cisco TrustSec Solution
and is used here for assigning labels to an organization’s security policy. As an example, Quarantined
System SGT will be applied to an ANC quarantine policy to monitor and not enforce network access.

Port-bounce will bounce the port the endpoint is connected, and user will be re-authenticated.

Port-shut will issue a shutdown on the port the endpoint is connected. This is the most severe and
may be issued if the endpoint is infected with malware and the malware is in suspect of propagating
over file shares.

These ISE ANC policies will be used by the Cisco ISE pxGrid app to enforce mitigation actions on the
endpoints from either the Dashboard and Panels or through IBM QRadar system syslog events as long
as the endpoint has been authenticated through ISE.

The following Cisco ISE ANC policies will be created:

e pxGridQRadarQuarantine - issues a quarantine
o pxGridQRadarPortBounce - issues a port-bounce
e pxGridQRadarShutDown - issues a shut down

The Cisco ISE pxGrid app will read in the existing ISE ANC policies; however, these default ANC
policies need to be configured first. Also, the Cisco ISE pxGrid app pxGrid client will need to be added
to the pxGrid ANC Group. You will perform this exercise later, when configuring the Cisco ISE pxGrid
for pxGrid integration.
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Configuring Default ANC policies for Cisco ISE pxGrid App

Go to Operations > Adaptive Network Control > Policy List > Add > The following for the Policy
Note:  When yNasme ardidcetionGrid app will automatically create default ANC policies if they don’t
exist. These policies shown in the paragraph about are hard coded and cannot be edited. If you

2;\3 sﬁiﬁﬁam&gg@&% ’%ﬁﬁ%:mmm,w ISE. These policies are populated

Step 1 .
pxGridQRadarPortBounce, PORT_BOUNCE
pxGridQRadatShutDown, SHUT_DOWN,
Select Save.
Step 2 After Policy Name and associated action, you should see the following:
‘Useh’  Identity Services Engine Home  » ContextVisibility [EEelSctl
» RADIUS  Threat-Centric NAC Live Logs » TACACS  » Troubleshoot =~ Adaptive Network Ct
Policy List  Endpoint Assignment
e Co——
List
0 Selected
2 Refresh =4 Add T Trash~ Edit
_| Policy Name ANC Actions
B pxGridQRadarQuarantine QUARANTINE
& pxGridQRadarPortBounce PORT_BOUNCE
B pxGridQRadarShutDown SHUT_DOWN
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Adding ANC Policies to ISE Policy Sets

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9
Step 10

Note:

Step 11
Note:

Go to Policy > Policy Sets > Default > ">" > Authorization Policy > Global Exceptions > "+".
Under Rule Name, type: ANC Quarantine.

Under Conditions, select "+".

To close the introductory screen, select "x".

Under Dictionary, select Session > ANCPolicy > Equals > pxGridQRadarQuarantine.

Select Use.

Under Profiles, select Permit Access.

Under Security Groups, select Quarantine_Systems.

Select Save.

Perform steps 1-9 for the Rule Name ANCShutDown and ANCPolicy pxGridQRadarShutDown.

You can also click on the Gear and duplicate line below and add the rule name and
ANCPolicy.

Perform steps 1-9 for the Rule Name ANCPortBounce and ANCPolicy pxGridQRadarPorBounce.

You can also click the Gear icon and duplicate line below and add the rule name and
ANCPolicy.

You should see the following:

il |dentity Services Engine Home  » ContextVisbilty  » Operations

Policy Sets | Profiling Posture  Client Provisioning  » Policy Elements

O]

Click here to do wireless setup and visibility setup Do no|

Default Default policy set Default Network Access

? Authentication Policy (3)

¥ Authorization Policy - Local Exceptions

¥ Autherization Policy - Global Exceptions (3]

Results
+
Status Rule Name Conditions Profiles Security Groups
] ANCQuarantine =3 Session‘ANCPolicy EQUALS pxGridQRadarQuarantine * PermitAccess + Quarantined_Systems x v &
@ ANCPortBounce £ Session-ANCPolicy EQUALS pxGridQRadarPortBounce * PermitAccess + Quarantined_Systems x v +
(©] ANCShutDown =3 Session‘ANCPolicy EQUALS pxGridQRadarShutDown * PermitAccess + Quarantined_Systems x v &
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Performing Cisco ISE ANC Mitigation Actions Through Cisco
ISE pxGrid App Dashboard Panel

This section steps the reader through performing ANC mitigation actions on the endpoint from the
dashboards and panels.

User pxGrid1 authenticates in ISE.

i Identity Services Engine Home » Context Visibility ~ Operations » Policy » Administration » Work Centers License Waming &

~RADIUS = Threat-Centric NAC Live Logs  » TACACS » Troubleshoot  » Adaptive Network Control  Reports
Click here to do wireless setup and visibility setup Do not show this again.
Live Logs  Live Sessions
—

Ste
ed o Network Devices @ RADIUS Drops @ Client Stopped Responding @ Repeat Counter @
Refresh | Never + Show Latest 20 records % Within Last3 hours v
< Refresh  © ResetRepeat Counts & Export Tov Y Fitterv &~
Time Status Details Repeat ... Identity Endpoint ID Endpoint P...  Authentication Policy Authorization Policy Authorizati.
X s Identity Endpoint ID Endpoint Prof Authentication Policy Authorization Policy Authorizatio
Mar 09, 2018 07:18:30.952 PM o a 0 pxgrid1 00:50:56:86:8B:13 Microsoft-W... Default >> Dot1X Default >> Basic_Authenticat... PermitAcces!
Mar 09, 2018 07:18:30.671 PM a pxgrid1 00:50:56:86:8B:13 Microsoft-W... Default >> Dot1X Default >> Basic_Authenticat... PermitAcces:
Mar 09, 2018 07:18:18.872 PM a host/win7-pc3 00:50 13 M ft-W... Default >> Dot1X Default >> Basic_Authenticat... PermitAcces:
Mar 09, 2018 07:17:51.173 PM ﬂ a host/win7-pc3 00:50:56:86:8B:13 Microsoft-W... Default >> Dot1X Default >> Basic_Authenticat... PermitAcces!
Step 2

Go to Cisco ISE pxGrid > Passed Authentications.

Dashboard ~ Ofienses  LogActity  MeiworkActvity  Assefs  Reports  Admin  Puse  UseCaseManager  PreVaidson  CiscolSE pxGrid System Tame: 4:54 pm

Passed Authentications 2021-07-06 16:47 - 2021-07-07 16:47

All Wired

20

23

20

g

¥ o

o

8 - 5 ° 4 R
- - * - 5 ; A B - 2 2 2 2 2
L & o & o - - o - o Z‘} 4\ {g

2
Y S >

Wireless VPN

w
[N
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Select an end user, ScaleUser7, and then see the following:

Data For : ScaleUser7

Show entries
Dev Time - IP Address State MAC Address Username Calling Station ID Called StationID NAS IP Address NAS Port ID NAS Port Type NAS Identifier Posture Statu
Ste 06-Jul-2021 09:46:19274 GMT+5:30 = 21.00.15 STARTED 2B:£4:00:06 = ScaleUser7 95:70:28:E4:00:06 None 111 GigabitEthernet1,”] Ethernet None None
06-Jul-2021 09:46:19.274 GMT+5:30  21.00.15 STARTED ScaleUser7 95:70:28:E4 6 None 1111 GigabitEthernet1,”] | Ethernet Mone Nene
3
Showing 1to 2 of 2 entries Previous
Right-click on the IP address, and then see the ANC policies:
Data For : ScaleUser18 X
Ste
Show entries
o] - Dev Time IP Address Failure Reason Username Server Name Authentication Protocol Device Type Location Calling Station ID
1614089477942030 = 15-Mar-2021 09:03:04.892 GMT+5:30 = 21.0J password or invalid shared secret = ScaleUser18 ciscoisepripsn PAP_ASCH All Device Types = All Locations = 95:70:2B:E4:00:11
1614089477942030  15-Mar-2021 09:03:04.892 GMT+5:30  21.0, pxGridQRadarShutDown password or invalid shared secret | ScaleUser1d ciscoisepripsn PAP_ASCI All Device Types | All Locations | 95:70:2B:E4:00:11
policy_demojk-09
1614089477942030  15-Mar-2021 09:03:04.892 GMT+5:30 210, pyGridgRadarPortBounce Password or invalid shared secret | ScaleUserid ciscoisepripsn PAP_ASCI All Device Types | All Locations | 95:70:2B:E4:00:11
1£14N2GATTIOAINZA | 1S Rdar INI1 AONTNA 863 SRITLE2N | 31 ANIR IINAN Wimmmn mzceinrd mr imuslin chzean rarest | Cralalleart® | siermicameinen oAD acen Al Pimire Timse | Al Larstinne | OSTNAIREAAN

Step 5 Select pxGridQRadarPortBounced.

Step 6
P You should see a successful status message:

IBM QRadar 192.168.0.250 says

p  Status: RUNNING
Operation Id : ciscoisepripsn.aujas-bir.local:95

Reports  Admin

Data For : ScaleUser7

show [10 ~entries
Dev Time . IP Address State MAC Address Username Calling Station ID Called StationlD NAS IP Address NAS Port ID NAS Port Type NAS Identifier Posture Statu
06-Jul-2021 09:46:19.274 GMT+5:30 STARTED 2B:E4:00:06 ScaleUserT None 111 GigabitEthernet1, ] Ethernet None None
Step 06-Jul-2021 09:46:19.274 GMT+5:30 21.00.15 STARTED = 95:70:2B:E4:00:06 ScaleUserT None 111 GigabitEthernet1, ] Ethernet None None

Showing 1 to 2 of 2 entries Previous

Select OK.
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To view in ISE, select Operations > RADIUS LiveLogs.

Based on the ANCQuarantine Policy, the endpoint has been quarantined:

‘thul: dentity Services Engine S ) Poicy  » Administration  » Work Centers

~RADIUS = Threat-Centric NAC Live Logs  » TACACS » Troubleshoot  » Adaptive Network Control  Reports
Click here to do wireless setup and visibility setup Do not show this again

Live Logs  Live Sessions

Ste|
S [: ] Network Devices @ RADIUS Drops & Client Stopped Responding @ Repeat Counter @
Refresh Never ¥ Show Latest 20 records % Within | Last 3 hours s
< Refresh © Reset Repeat Counts 2 Export Tov Y Fitterv o~
Time Status Details Repeat ... Identity Endpoint ID Endpoint P...  Authentication Policy Authorization Policy Authorizati.
x 3 Endpoint ID Endpoint Profi | | Authenticatic Authorization Policy Authorizatio
Mar 09, 2018 07:29:29.662 PM 0 Q 0 pxgrid1 00:50:56:86:8B:13 Microsoft-W.. Default >> Dot1X Default >> ANCQuarantine Quarantined.
Mar 08, 2018 07:29:29.506 PM n a pxgrid1 00:50:56:86:8B:13 Microsoft-W. Default >> Dot1X Default >> ANCQuarantine Quarantined.
Mar 09, 2018 07:29:28.709 PM ~] Qo 00:50:56:86:BB:13
To view the quarantine details in the Cisco ISE pxGrid App ANC Dashboard, go to Cisco ISE
Step 9 pxGrid > ANC Details.

See an example of the MAC Address of the quarantined endpoint:

=  IBMQRadar € 0 9

Offienses Log Actiity Metworc Actvity  Assets Reports Admin Pulse UseCzse Msmager  PreValidation Cisco ISE pxtrid System Time: 458 pm

ANC Details 2021-07-06 16:47 - 2021-07-07 16:47

Currently Assigned ANC policy

Show|[10_w ] entries

Mac Address. * Policy Name

88:B1:11:EFF8:12 pxGridQRadarPortBounce
95:70:2B:E4:00:05 policy_demojk-08
prGridQRadarPortBounce
test_u
95iT0:2B:E4:00:08 testaddition
AZED2T.C2:51:DC pxGridQRadarPortBounce
F8:87:F1:3C:58:9E pxGridQRadarPortBounce
Showing 1to 7 of 7 entries Previous E MNext
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To view the details in the Cisco ISE pxGrid App TrustSec Dashboard, go to Cisco ISE pxGrid >
Trusts.

IBM QRadar Security Intelligence

Dashboard Offenses LogActivity Network Activity Assets Reports Risks Vulnerablliies Admin ELLIN Y3 el ]

2018-03-03 14:34 - 2018-03-09 14:34

St8| Passed Authentications Failed Authentications Devices Compliance Trustsec MDM ANC Details
Group Tag (All) Group Tag (Wired)
57 55
W 40
20 20
7 5
: 1 : I
Quarantined Quarantined,
Systems Systems
Step 11 To see the quarantined endpoints, select Quarantined_Systems:

IBM QRadar Security Intelligence

Dashboard Offenses LogActivity Network Activity Assets Reports Risks Vulnerabilities Admin ReELLRIE F0{ch ]

Data For : Quarantined_Systems X
Show| 10 4 entries
Dev Time v IP Address State MAC Address Username Calling Station ID Called StationID NAS IP Address NAS Port ID
09-Mar-2018 02:29:29.662 EST  192.168.1.15 STARTED 00:50:56:86:BB:13 pxgrid1 00:50:56:86:BB:13 50:3D:E5:C4:05:8B  192.168.1.3 GigabitEthernet1/0/1
Ster 08-Mar-2018 11:05:58.744 EST 192.168.1.15 STARTED 00:50:56:86:BB:13 pxgrid1 00:50:56:86:BB:13 50:3D:E5:C4:05:8B 192.168.1.3 GigabitEthernet1/0/1
08-Mar-2018 10:24:20.697 EST ~ 192.168.1.57 DISCONNECTED  88:CB:87:ED:45:DA  88:CB:87:ED:45:DA  88:CB:87:ED:45:DA 50:3D:E5:C4:05:83  192.168.1.3 GigabitEthernet1/0/2
Ster_ lvOB-Mar-2018 10:24:20.597 EST 192.168.1.57 DISCONNECTED  88:CB:87:ED:45:DA  88:CB:87:ED:45:DA  88:CB:87:ED:45:DA 50:3D:E5:C4:05:83  192.168.1.3 GigabitEthernet1/0/2

To un-quarantine or clear the endpoint either in the Dashboards or directly in ISE. The
endpoint will be un-quarantined from this view.

Right-click on the MAC Address:
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IBM QRadar

Ofienses  LopAcivty — MetworkAcivity  Assets  Repors  Admn Puse  UseGamseMamager  PreVeidaion  GiscolSEpuGrd

Data For : ScaleUser7

Show entries
Dev Time . IP Address State MAC Address Username Calling Station ID Called StationlD NAS IP Address NAS Port ID NAS Port Type MNAS Identifier Posture Statu
06-Jul-2021 09:46:19274 GMT+5:30 = 21.0. STARTED 2B:E4 i 5 g = None 1114 GigabitEthernet1 7] Ethernet None None
06-Jul-2021 09:46:19.274 GMT+5:30 | 21.00.15 STARTED BB policy_demiok-0s ¥5:70:28:£4:00:06 MNone 1111 GigabitEthernet1,”] | Ethernet Nane Naone
pxGridQRadarPortBounce s
pxGridQRadarClear
showing 1 to 2 of 2 entries Previous

Select pxGridQRadarClear.

You should see successful status message:
Step 14
IBM QRadar

Offenses
scoisepripsn.aujas-bir.locakos

Data For : ScaleUser7

Dev Time o 1P Address State MAC Address Username Calling Station ID Called StationID NAS IP Address NAS Port ID NAS Port Type NAS Identifier Posture Statu
06-Jul-2021 09:46:19.274 GMT. 21.00.15 STARTED ScaleUser? None 1144 GigabitEthernet1, 7] Ethernet None None
06-Jul-2021 09:46:19.274 GMT. 21.0. STARTED 06 | ScaleUser? None 111 GigabitEthernet1 7] Ethernet MNone None

»
showing 1to 2 of 2 entries Previous
Ste|
Step 17

Select OK.

To un-quarantine the endpoints and view the results in ISE, go to Operations > RADIUS > Live
Logs.

~ Operations » Policy » Administration » Work Centers icense Waming 4

vRADIUS = Threat-Centric NAC Live Logs  » TACACS » Troubleshoot  » Adaptive Network Control  Reports
Click here to do wireless setup and visibility setup Do not show this again

LiveLogs  Live Sessions
e

s (i ] Network Devices @ RADIUS Drops © Client Stopped Responding & Repeat Counter &
Refresh Never ¥ Show Latest 20 records % Within Last3 hours s
< Refresh @ ResetRepeat Counts & Export Tow Y Filterv ¥~
Time Status Details Repeat ... Identity Endpoint ID Endpoint P...  Authentication Policy Authorization Policy Authorizati.
X s dentity Endpoint | Endpoint Authentication Policy Authorization Pc Authorizat
Mar 09, 2018 07:48:43.693 PM o a 0 pxgrid1 00:50:56:86:8B:13 Microsoft-W. Default >> Dot1X Default >> Basic_Authenticat. PermitAcces:
Mar 09, 2018 07:48:42.916 PM u a pxgrid1 00:50:56:86:8B:13 Microsoft-W... Default >> Dot1X Default >> Basic_Authenticat... PermitAcces!
Mar 09, 2018 07:45:52.604 PM ﬂ a pxgrid1 00:50:56:86:8B:13 Microsoft-W. Default >> Dot1X Default >> Basic_Authenticat. PermitAcces:
Mar 09. 2018 07:45:51.107 PM (] P 00:50:56:86:88:13
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Go to Cisco ISE pxGrid > ANC Details, you should see the endpoint is no longer assigned to the
ANC policy:

IBM QRadar Security Intelligence

Dashboard Offenses LogActivity NetworkActivity Assets Reports Risks Vulnerablliies Admin RIS Ao cl]

Passed Authentications Failed Authentications Devices Compliance Trustsec MDM ANC Details

Currently Assigned ANC policy

Show| 10 %|entries
Mac Address *  Policy Name

No data available in table

Showing 0 to 0 of 0 entries Previous Next

Note:  To un-guarantine or clear in ISE: go to Operations > Adaptive Network Control > Endpoint
Assignment > Select the endpoint MAC address > Tras.
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Configuring IBM QRadar for Cisco ISE Syslog Events

The IBM Device Support Module (DSM) for Cisco Identity Service Engine (ISE) Syslog is installed by
default on QRadar. For more information on DSM (beyond the scope of this guide) visit the DSM guide.

Configure log source on IBM QRadar.

Configure both primary and secondary MNT log sources in an HA environment.
Note:  Support of DSM comes from IBM Support, this information is added for your benefit but not

Open the IBM QRadar Console.

Step 1
Note: G0 to Admin > Data Sources > Log Sources.
a.
b- Admin bbeploy Changes Advanced ¥
» System Configuration JAJ There are no changes to deploy.
v Data Sources Data Sources
« Events
+ Flows Events

« Vulnerability

' - v

Remote Networks and - .
Services Configuration DSM Editor WinCollect Log Sources

Try it out

Add in a new log source for Cisco ISE Syslog.
Add a new log source > Single Source > Source Type: Identity Services Engine.

e Log Source Name and Description: Cisco_ISE
e Log Source Type Cisco Identity Services Engine
e Protocol Configuration: UDP Multiline Syslog
Note: o | og Source Identifier: IP Address of your ISE MNT node(s)
e Listen port (leave default 517)
e Message ID Pattern: c1se_\s+ (\d{10})

e Source Name Formatting String (researching)
For version 7.3, there will be a single screen configuration.
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Log Source Summary X

Cisco_ISE
Cisco loentity Senvices Enging 1981813327
Status: CK Last Upoatea 3 months age
Overview Protocol
Name™ (O Cisco_|SE
Description (O Cisco_|SE
Log Source Type O Cisco |dentity Services Engine ¥
Protocol Type () UDP Muttiine Sysiog v
Enabled @ @

Groups

None Availabie

Extension ()

For QRadar 7.4, this will open a new application window and will take you through a

Note: . . .

guided configuration.
d. Select Save or Finish, close the new app window.
e,

Select Deploy Changes > Deploy.
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Configuring Cisco ISE Syslog Events

Cisco ISE will be configured to send syslog information to the IBM QRadar instance. Please make sure
you have the QRadar ISE DSM installed. Future releases of the QRadar ISE DSM will include ISE syslog
events such as Framed IP Address, IP address, where you can take ANC mitigation actions on the

endpoint.

Go to Administration > System > Logging > Remote Logging Targets.

Add in a new Remote logging target - Host/IP address of IBM QRadar instance:

e Port - non-default 517 (QRadar UDP multiline listening port)

Step 1
e Maximum length of 8192 (to see complete logs instead of those truncated)
Step 2 .
¢ Include alarms for this Target (checked)
g-'al.- Identity Services Engine Home » Context Visibility » Operations ~ Administration » Work Centers
«System  » Identity Management  » Network Resources  » Device Portal Management  pxGrid Services  » Feed Service  » Threat Centric NAC
Deployment  Licensing » Certificates ~Logging » Maintenance  Upgrade » Backup & Restore  » Admin Access  » Settings
o
Local Log Settings Remote Logging Tangets List > qradar
Logging Target
Remote Logging Targets
*Name qradar Target Type  UDP Syslog
Logging Categories
Messagé Catalog Description [ ] Staws [ Enabled ~
Debug Log Configuration * Host / IP Address l— |
Collection Filters *Port [517 | (valid Range 1 to 85535)
Facillty Code [LOCALE v
* Maximum Length | 8192 | (valid Range 200 10 8192)
Include Alarms For this Target (V]
Step 3 B | e
Step 4

Select Submit/Save.
Configure Logging Categories:

Choose AAA Audit element > Edit.
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Gl dentity Services Engine Home » Contex

g1s<o isibility » Operations » Policy

- System » |dentity Management  » Network Resources » Device Portal Management  pxGrid Servi

Deployment  Licensing » Cedificates +Logging » Maintenance Upgrade » Backup & Restor

|
i
Log Settings Logging Categories
Remote Logging Targets
. . 7 Edit
Logging Categories -
Parent Categor Categor

Message Catalog wory wory

® asa Audt AAA Audit
Nehiin | nn Canfinuratinn ~

Move QRadar from Targets Available into the Selected column.
Step 5 . .
P Don’t worry about the local logging checkbox, leave it alone.
‘dics’ Identity Services Engine Home  » ContextVisbiity  » Operations  » Policy [ LIG (.8 » Work Centers
~System | » Identity Management  » Network Resources  » Device Portal Management  pxGrid Services  » Feed Service  » Threat Centric NAC

Deployment  Licensing » Certificates ~Logging » Maintenance Upgrade » Backup & Restore  » Admin Access  » Settings

[ el
(<]
Local Log Settings Logging Categories List > AAA Audit
Remote Logging Targets Logging Category
Logging Categories Name AAA Audit
Message Catalog Log Severity Level INFO
Debug Log Configuration ( Log level can not be changed. )
Collection Filters Local Logging
Targets .
Available: Selected:
ProfilerRadiusProbe LogCollector
SecureSyslogColiector qradar
Ste|
»
<
Select Save.
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Perform previous steps for additional elements: Passed Authentications, Failed Attempts,
Accounting, RADIUS Accounting, Administration and Operational Audit, Posture and Client
Provisioning Audit, and Profile.

When completed, you should see elements with QRadar listed in the Targets column where

appropriate.

Step 7

Ste|

atfsenfne
cisco

Identity Services Engine

Home

» Context Visibility

» Operations

» Policy ~ Administration

~System | » Identity Management  » Network Resources  » Device Portal Management  pxGrid Services  » Feed Service
Deployment  Licensing  » Certificates ~Logging » Maintenance  Upgrade  » Backup & Restore  » Admin Access
_
[<] / Edit
Local Log Settings Parent Category Category
O ana Audit AAA Audit

Remote Logging Targets
Logging Categories
Message Catalog
Debug Log Configuration

Collection Filters

(ONONOHONONONOHONORONOHONONONOHONORONOHONONONOHONONO)

AAA Diagnostics

Accounting

Administrative and Operational Audit
External MDM

PassivelD

Posture and Client Provisioning Audit

Posture and Client Provisioning Diagnostics

Profiler
System Diagnostics

Failed Attempts
Passed Authentications
AAA Diagnostics

Administrator Authentication and Authorization

Authentication Flow Diagnostics
Identity Stores Diagnostics
Policy Diagnostics

RADIUS Diagnostics

Guest

MyDevices

AD Connector

TACACS Diagnostics
Accounting

RADIUS Accounting

TACACS Accounting
Administrative and Operational Audit
External MDM

PassivelD

Posture and Client Provisioning Audit

Posture and Client Provisioning Diagnostics

Profiler

System Diagnostics

Distributed Management
Internal Operations Diagnostics
Licensing

Threat Centric NAC

» Settings

» Work Centers

» Threat Centric NAC

Targets

LogCollector,qradar
LogCollector,ProfilerRadiusProbe,qradar
LogCollector,ProfilerRadiusProbe,qradar
LogCollector

LogCollector

LogCollector

LogCollector

LogCollector

LogCollector

LogCollector,gradar
LogCollector,ProfilerRadiusProbe,qradar
LogCollector

LogCollector,qradar

LogCollector

LogCollector
LogCollector,ProfilerRadiusProbe,qradar
LogCollector

LogCollector,qradar

LogCollector

LogCollector
LogCollector
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INFO
INFO
INFO
WARN
WARN
WARN
WARN
WARN
WARN
INFO
INFO
INFO
WARN
INFO
INFO
INFO
INFO
INFO
INFO
INFO
WARN
INFO
WARN
WARN
WARN
INFO
INFO

Pag

Shi

Local Log L
enable
enable
disable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
enable
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Performing ISE ANC Mitigation Actions Through IBM QRadar
Syslog Events

The desired endpoints for performing ANC mitigation actions must have been authenticated through
ISE. In this example, we have Cisco ISE Passed Authentication syslog events sent over to IBM QRadar.
We have to create a custom FramedIPAddress field to provide the IP address of the endpoint.

Norhe E¥htfediPridureisshfidlaMailcper. s diigthavapaitdtie cestimns, field in the Log Activity Search
FrameElPASE:sts field. You may need to add additional fields. These have been included in the
e

Creaxﬁge ion. This is still required in the version 7.4 of QRadar.

The FramedIPAddress field will now appear in ISE Log Activity searches.

Note:  You will see a group already created for Cisco ISE pxGrid. This is strictly to use with pxGrid data
sources. The following group you’re making is for additional support of syslog messages that
provide more information than the pxGrid source. This helps you working with additional
functionality of QRadar that is beyond the scope of the pxGrid app.

Creating Custom Field for Framed IP Address ISE Syslog Event

S
b In IBM QRadar, go toLog Activity > Search > New Search > Manage Groups.

Create New Group > Cisco_ISE.

You should see the Cisco ISE group:

@ Event Search Groups - Mozilla Firefox

© £ https://198.18.133.50/console/do/core/generictree

| New Group [ ¥ Edit Copy E¥Remove
=) u A Name User Desi
3 Authentication, Iden () Authentication, Iden...  admin Information about user authorizatic
2 Cisco ISE pxGrid [0 Cisco ISE pxGrid admin
23 Cisco_ISE [ Cisco_ISE admin Syslog ISE
L3 Compliance () Compliance admin Information related to a variety of c(
=HCJ Log Sources ) Log Sources admin This group contains log source sp
=10 Antivirus [0 Network Monitoring ... admin Information related to monitoring a
L ACS () Security (Malware, ... admin Information related to security of ne
L All Antivirus | System Monitoring (... admin Information related to the health ar
) Endpointprote () Usage Monitoring admin Information around the usages of ¢
0 McAfeeEpo () Other admin The group contains ungrouped iter
) Officescan
0 SymantecSys
=10 Applications f O€
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Close the Search groups page and select the newly created Cisco_ISE Group for Saved

Searches.

IBM QRadar Security Intelligence

Sten 2 LLY.Ya0% 8 Network Activity Assets Reports
ep

{ Manage Search Results ‘Q Manage Custom Properties

Saved Searches Group:Cisco_ISE

[ | Manage Groups
Keep the Search defaults.

B1C]  IBM QRadar Security Intelligence

(RPN Network Activity Assets Reports Risks Vulnerabllittes Admin Cisco ISE pxGrid

§ Manage Search Results | ()} Manage Custom Properties

Search Mode
© Basic Search Advanced Search
Time Range:
© Real Time (streaming) " Last Interval (auto refresh) " 'Recent ") Specific Interval
Last 5 Minutes j Start Time
End Time
Cisco Systems © 2021
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Keep the column defaults.

Column Definition

Display: | Default {(Normalized) j

Step | ¥ Advanced View Definition
Type Column or Select from List

Available Columns

Source or Destination IP
Category

Destination Asset Name
Destination IP

Destination Port

Log Source

Log Source Group

Source Asset Name
Source IP

Event Name

Event Description

Domain

Anomaly Alert Value
Associated With Offense
Credibility

Custom Rule

Custom Rule Partially Matched
Custom Rule Partial or Full Matched
Destination MAC
Destination Network
Destination Network Group
Duplicate

Step 5

Group By:

Columns

Event Name
Log Source
> Event Count
< Start Time
Category
Source IP
Source Port

Order By:
Start Time

Results Limit
| 1,000

Under Search Parameters > Parameter > Quick Filters.

—

_:l Desc :I

Go to Log Source (Indexed) > Equals > Log Source Filter > Cisco_ISE Add Filter.

Search Parameters

Parameter: Operator:

Value:

Log Source [Indexed] ~ ~ | | Equals | ~ | 1og Source Filter: Type to Filter

Current Filters

Log Source:

Anomaly Detection Engine-2 :: qrada...

Asset Profiler-2 :: qradar2
Cisco_ISE
Custom Rule Engine-8 :: gradar2

IR Mot 2 ;- Gradae

Log Source is Cisco_ISE

Remove Selected Filters

Add Fiiter
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Click Search.

IBM QRadar Security Intelligence

[BLPGI Network Activity Assets Reports Risks Vulnerabliities Admin  Cisco ISE pxGrid

Search... ¥ Quick Searches ¥ Y AddFiter |5 Save Criteria [ Save Results g Cancsl *\, Faise Postive Rules ¥ Actions ¥ > @

Quick Filter ¥ Search

Ste|

Viewing real time events (Paused) View:| Select An Option: | =~ Display:| Default (Normalized) | ~

Current Filters:
Log Source is Cisco_ISE  (Clear Filter)

Event Name Log Source Event Count Time v Low Level Category Source IP Sgl;:‘ce Destination IP D”'P'::‘“"
PASSED_AUTH Cisco_ISE 1 Mar 11,2018, 7:47:4... Misc Login Succeeded 192.168.1.3 0 192.168.1.147 1645
RADIUS_ACCOUNTING_UPDATE Cisco_ISE 1/ Mar 11, 2018, 7:47:4... RADIUS Session Status 192.168.1.3 0 192.168.1.147 0
PROFILER_ENDPOINT_PROFILING_EVENT Cisco_ISE 1 Mar 11, 2018, 7:47:4... Information 192.168.1.3 1645 192.168.1.147 1645
PROFILER_ENDPOINT_PROFILING_EVENT Cisco_ISE 1 Mar 11,2018, 7:47:4... Information 192.168.1.3 1645 192.168.1.147 1645
CiscolSE_Alarm Cisco_ISE 1 Mar 11, 2018, 7:47:3... Waming 192.168.1.147 0 192.168.1.147 0
FAILED_AZN_ONLY Cisco_ISE 1 Mar 11, 2018, 7:47:3... General Authentication Failed 192.168.1.147 0 192.168.1.147 0
FAILED_AZN_ONLY Cisco_ISE 1 Mar 11,2018, 7:47:3... General Authentication Failed 192.168.1.147 0 192.168.1.147 0
FAILED_AZN_ONLY Cisco_ISE 1 Mar 11,2018, 7:47:2... General Authentication Failed 192.168.1.147 0 192.168.1.147 0
PROFILER_ENDPOINT_PROFILING_EVENT Cisco_ISE 1 Mar 11,2018, 7:47:2... Information 192.168.1.3 1645 192.168.1.147 1645

Note:  The following steps will work with a wired connection, however with a wireless connection you will

need to check RADIUS Accounting events. | . .
In the upper right corner, click Pause, and then double-click Passed Auth (wired) or

Step 7 Radius_Acct (wireless).

Step 8 Click Extract Property and for New Property, then type: FramedIPAddress.

Dashboara Cffenses Lag Activity Meatwork Activity Asmat aports Risks Vulnerabities Admin

Retum to Event List [1; Offense iy Map Event 'ﬂ-. False Fositive | ) Extract Property .._z Frevious .3 Next _ FPrint (¢ Obfuscation

Extract a custom property from the payload of this event |

Event Infermatien

Event Hame PASSED_AUTH
ste  Low Level Categony Misc Login Succeeded

Ste| | BEvent Description User authentication ended successiully

Step.11
For Field Type, type: IP.

For Description, type: FramedIPAddress.

For Extraction > RegEx > type: Framed-IP-Address=(\b\d{1,3]\.\d{1,3\.\d{1,3}\.\d{1,3}\b).
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You should see:
Property Definition
(" Existing Property: ‘ Select a property... :I
©New Property: FramediPAddress
[ |Optimize parsing fo!' mles. Leﬁponsfiagnd searches
Field Type: P ;l
Descnpfion: F.rarn.e.si.lmqr.eﬁs
Vi
Property Expression Definition
Enabled:
Selection
Log Source Type: \ Cisco Identity Services Engine ;'
Log Source: Al ;I
©Event Name: PASSED_AUTH Browse
— High Level Category ‘ Authentication j
(_Category: i
Low Level Category | Misc Login Succeeded j
Extraction
RegEx: Framed-IP-Address=(\b\d{1,3}\.\d{1,3}\.\a{1,3)\.\d{1.3)\b) Capture Group: 1 Test
Step .-
Select Test.
You should see:
Text matching your expression has been highlighted in the payload.
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Select OK.

Select Save.

Ensure the FramedIPAddress appeared:

Step 13 IBM QRadar Security Intelligence

Step 14 [RL.Y.CULT Network Activity Assets Reports Risks Vulnerabilities Admin  Cisco ISE pxGrid

Step 15 [5] Retum to Event List  [8] Offense &) Map Event . False Positive i} Extract Property @) Previous €Next (2 Print (§) Obfuscation ¥
Event Information
Event Name PASSED_AUTH
Low Level Category | Misc Login Succeeded
Event Description User authentication ended successfully
Magnitude U S —
Username pxgrid1
Start Time Mar 11, 2018, 7:47:42 PM I Mar 11, 2018, 7:47:42 PM
FramedIPAddress
(custom) 192.168.1.15
Select Return to Event List.
Step 16
Step 17 Select Search > Edit Search > Saved Searches > Group: Cisco_IS.
Step 18

Note:  You caC UMPARS Ry v8RLEGkAE of Rcrolling through list.

Scroll down to Column Definition > Available Columns > FramedIPAddress(Custom) > Move to
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IBM QRadar Security Intelligence

ST
CIsCcoO

P 0Y Network Activity Assets Reports Risks Vulnerabllities Admin Cisco ISE pxGrid

Display:

Manage Search Results Q Manage Custom Properties

Custom

i

Name: Save Column Layout

¥ Advanced View Definition
Type Column or Select from List

Available Columns_ ) Group By:
Dormant Offense Count {custom) =
Duration_Hours (custom) s 1
Duration_Minutes (custom) < !
Duration_Seconds {custom)
Element (custom)
Event Summary (custom)
EventlD (custom) Columns
Events per Second Coalesced - Average 1 Min (custom) Source IP
Events per Second Coalesced - Peak 1 Sec (custom)
Events per Second Raw - Average 1 Min {custom) Source Port
Events per Second Raw - Peak 1 Sec (custom) Destination IP N
External ID {custom) = 1
File Hash (custom) pr Destination Port ;
File ID {custom) =
File Path (custom) Usamname
Filename (custom) Magnitude
Flow Source (custom)
Flows per Second - Average 15 Min (custom) FramediPAddress {custom)

Flows per Second - Peak 1 Min {custom)

FramedIPAddress (custom) Order By:
FramedIPAddress2 (custom) =~ =
Function code (custom) e J — _I
Results Limit
1,000 =

Step 1

Select Filter. Now, you should see the custom FramedIPAddress field:

IBM QRadar Security Intelligence

(BP0 Network Activity Assets Reports Risks Vuinerablliies Admin  Cisco ISE pxGrid

Search.. ¥ Quick Searches ¥ Y AddFiter |5 Save Criteria [} Save Resuits g Cancel %\, Faise Positive Rules ¥ Actions ¥

luick Filter v Search

Viewing real time events (Paused) ~ View:| Select An Option: |~ | Display: Custom |~

irrent Filters:
og Source is Cisco_ISE  (Clear Filter)

Low Level FramedIPAddres¢

Event Name Log Source Event Count Start Time v Category Source IP Source Port P D Port L
PASSED_AUTH Cisco_ISE 1 Mar 11,2018, 8:... Misc Login Succ... 192.168.1.3 0 192.168.1.147 | 1645 pxgrid1 e ey 192.168.1.15
PASSED_AUTH Cisco_ISE 1 Mar 11, 2018, Misc Login Succ... 192.168.1.3 0 192.168.1.147 1645 pxgrid1 — - 192.168.1.15
PASSED_DYNAMIC_ATZ | Cisco_ISE 1 Mar 11,2018, General Authent... 192.168.1.3 0 192.168.1.147 |0 N/A — - N/A
RADIUS_ACCOUNTING... Cisco_ISE 1 Mar 11, 2018, RADIUS Sessio... 192.168.1.3 0 192.168.1.147 0 N/A — - N/A
FAILED_ATTEMPT_DY... Cisco_ISE 1 Mar 11,2018, General Authent... 192.168.1.3 0 192.168.1.147 | 0 N/A — - N/A
PASSED_DYNAMIC_ATZ | Cisco_ISE 1 Mar 11, 2018, General Authent.... 192.168.1.3 0 192.168.1.147 0 N/A — - N/A
CiscoISE_Alarm Cisco_ISE 1/ Mar 11, 2018, ‘Warning 192.168.1.147 0 192.168.1.147 0 N/A — - N/A
AUTHEN_PASSED Cisco_ISE 1 Mar 11,2018, Admin Login Su... 192.168.1.136 0 192.168.1.147 | 0 admin — - N/A
AUTHEN_FAILED Cisco_ISE 1 Mar 11,2018, Admin Login Fai... 192.168.1.136 0 192.168.1.147 | 0 admin — - N/A
RADIUS_ACCOUNTING... Cisco_ISE 1 Mar 11, 2018, 8:... RADIUS Sessio... 192.168.1.3 0 192.168.1.147 |0 N/A [E———— N/A
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ANC Mitigation Syslog Event Example

The user has been successfully authenticated through ISE.

‘sl Identity Services Engine Home  »ContextVisbity Rl ‘Foly »Admiistation  » Work Centers

~RADIUS = Threat-Centric NAC Live Logs  » TACACS  » Troubleshoot  » Adaptive Network Control  Reports.
Click here to do wireless setup and visibility setup Do not show this again

Live Logs  Live Sessions
—_—

L ] Network Devices @ RADIUS Drops @ Client Stopped Responding @ Repeat Counter @
> 0 0 0 5 0
Refresh  Never ¥ Show Latest 20 records % Within Last3 hours :
< Refresh © Reset Repeat Counts & Export Tov Y Filter v - 24
Time Status Details Repeat ... Identity Endpoint ID Endpoint P...  Authentication Policy Authorization Policy Authorizati.
X ) Identity Endpoint ID Endpoint Profi Authentication Policy Authc Authorizatio
Mar 09, 2018 10:49:41.441 PM o o 0 pxgrid1 00:50:56:86:8B:13 Microsoft-W. Default >> Dot1X Default >> Basic_Authenticat... PermitAcces:
Mar 09, 2018 10:49:40.488 PM n a pxgrid1 00:50:56:86:8B:13 Microsoft-W... Default >> Dot1X Default >> Basic_Authenticat... PermitAcces:
In QRadar, select the syslog event, right-click FramedIPAddress, and then select More
Options.
Step 2 P

In the following example, a Passed authentication (or RADIUS Accounting) syslog event was
received from ISE:

IBM QRadar Security Intelligence

(RPN Network Activity Assets Reports Risks Vulnerabliities Admin  Cisco ISE pxGrid

Search.. ¥ Quick Searches ¥ Y AddFiter | Save Criteria [ Save Results g Cancsl *\, Faise Positive Rules ¥ Actions ¥ (%]

Records Matched Over Time
3/9/18, 5:24 PM - 3/9/18, 5:54 PM 4

S |
5024 PM 5:26 PM 5:28 PM 5:30 PM 5:32PM 5:34 PM 5:36 PM 5:38 PM 5:40 PM 5:42 PM 5:44 PM 5:46 PM 5:48 PM 5:50 PM 5:52 PM 5:54
Update Details

(Hide Charts)
Event Name Log Source Event Count Start Time v lg:g;?r:l Source IP Source Port D P Port L Fran(i:::::;irese

AUTHEN_PASS... Cisco_ISE 1 Mar9, 2018, 5:5... Admin Login Su...  192.168.1.136 0 192.168.1.147 | 0 admin — N/A
PROFILER_EN... | Cisco_ISE 1, Mar9, 2018, 5:4... Information 192.168.13 | 1645 192.168.1.147 | 1645 005056860013 M NIA
PROFILER_EN... 'Cisco_ISE 1| Mar g, 2018, 5:4... Information 19216813 1645 192.168.1.147 | 1645 005056860b13 M N/A
PROFILER_EN... Cisco_ISE 1 Mar, 2018, 5:4... Information 19216813 | 1645 192.168.1.147 | 1645 005056860013 | N/A
RADIUS_ACCO... Cisco_ISE 1 Mar9, 2018, 5:4... RADIUS Sessio...  192.168.1.3 0 192.168.1.147 0 N/A — - N/A

| [PASSEDAUTH |CiscolSE | 1|Mar9,2018 5:4...| MiscLogin Succ..| 18216813 10 | 192168.1.147 |
AUTHEN_PASS... Cisco_ISE 1 Mar9, 2018, 5:4... Admin Login Su...  192.168.1.136 0 192.168.1.147 0 Filter on FramedIPAddress (custom) is 192.168.1.15
PROFILER_EN... Cisco_ISE 1 Mar g, 2018, 5:4... Information 192.168.1.3 1645 192.168.1.147 Filter on FramedIPAddress (custom) is not 192.168.1.15
FAILED_AZN_... | Cisco_ISE 1 Mar 9, 2018, .| General Authent... 192.168.1.147 0 192.168.1.147 0 Filter on Source or Destination IP is 192.168.1.15
CiscolSE_Alarm | Cisco_ISE 1 Mar9, 2018, 192.168.1.147 | 0 192.168.1.147 0 )
CiscolSE_Alarm | Cisco_ISE 1 Marg, 2018, 192.168.1.147 0 192.168.1.147 0 QUIcK Fller...
CiscoISE_Alarm  Cisco_ISE 1 Mar g, 2018, 5: 192.168.1.147 0 192.168.1.147 0 False Positive
CiscolSE_Alarm | Cisco_ISE 1| Marg, 2018, 192.168.1.147 0 192.168.1.147 0| . view path from 192.168.1.3 to 192.168.1.147

1 Marg, 2018, 192.168.1.147 | 0 192.168.1.147 0

Unknown !sco ... Cisco IE View in DSM Editor

More Options... >

Displaying 1 to 15 of 15 ltems (Elapsed time: 0:00:00.098)

You can right-click the Source IP and Destination IP address. This will also work on
customized IP Fields.
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Select More Options > Cisco pxGrid - ANC Quarantine.

IBM QRadar Security Intelligence

[ELELUULTN Network Activity Assets Reports Risks  Vuinerabllities Admin  Cisco ISE pxGrid

Search.. ¥ Quick Searches ¥ Y Add Filter |] Save Criteria [ Save Results g, Cancel *\, Faise Positve Rules ¥  Actions ¥ 2]

Ste| Recoras Matched Over Time
35118, 5:24 PM - J9/18, 5:58 PM &

10
5
502£ PM 5:26 PM 5:28 PM 5:30 PM 5:32 PM 5:34 PM 5:36 PM 5:38 PM 5:40 PM 5:42 PM 5:44 PM 5:46 PM 5:48 PM 5:50 PM 5:52 PM 5:54 F
Update Details
(Hide Charts)
Low Level FramedI|PAddres:
Event Name Log Source Event Count Start Time v Category Source IP Source Port D P D Port L (custom)
AUTHEN_PASS... Cisco_ISE 1 Marg, 2018, 5:5... Admin Login Su.. 192.168.1.136 0 192.168.1.147 0 admin — - NiA
PROFILER_EN... | Cisco_ISE 1 Mar 8, 2018, 5:4... Information 192.168.1.3 1645 182.168.1.147 1645 00505686bb13 - NiA
PROFILER_EN... Cisco_ISE 1 Marg, 2018, 5:4... Information 192.168.1.3 1645 192.168.1.147 1645 005056860013 M N/A
PROFILER_EN... | Cisco_ISE 1 Mar 8, 2018, 5:4... Information 192.168.1.3 1645 192.168.1.147 | 1645 005056860013 e i NiA
RADIUS_ACCO... Cisco_ISE 1 Mar8, 2018, 5:4 RADIUS Sessio. 192.168.1.3 Navigate > N/A — - N/A
| |PASSEDAUTH [CiscoSE | 1|Mar0,2018, 6:4...| Misc Login Succ...| 182.168.13 format :
AUTHEN_PASS... Cisco_ISE 1 Mar 9, 2018, 5:4... Admin Login Su 192.168.1.136 nformation > Filter on FramedIPAddress (custom) is 192.168.1.15
PROFILER_EN... | Cisco_ISE 1/ Mar 8, 2018, 5:4... Information 192.168.13 | Run Vulnerability Scan Filter on FramedIPAddress (custom) is not 192.168.1.15
FAILED_AZN Cisco_ISE 1 Mar8, 2018, 5:4... General Authent 192.168.1.147 | Run Forensics Recovery Filter on Source or Destination IP is 192.168.1.15
CiscolSE_Alam | Cisco_ISE 1 Mar 8, 2018, 5:4... Waming 192.168.1.147
1 Run Fon Search
CiscolSE_Alarm | Cisco_ISE 1 Marg, 2018, 5:4... Waming 192.168.1.147 | un Forensics Searc Quick Filter...
GiscolSE_Alarm | Cisco_ISE 1 Mar 8, 2018, 5:2... Waming 192.168.1.147 | Plugin options > |4, False Positive
CiscolSE_Alarm | Cisco_ISE 1 Mar 9, 2018, . Waming 192.168.1.147 | Cisco pxGrid - ANC Quarantine % View path from 182.168.1.3 to 192.168.1.147
Unknown Jsoo Cisco, \E_ 1 Mar§, 2018, . Unknown 182.168.1.147 | Cisco pxGrid - ANC Shutdown View in DSM Editor
isplaying 1 to 15 of 15 ltems (Elapsed time: Cisco pxGrid - ANC Port Bounce More Options...
Step 4

You should see a successful status message:

IBM QRadar Security Intelligence 192.168.1.192 Says

NLEUGIL  Network Activity  Assets L. ANC action returned status: RUNNING
OK

Ste| search.. ¥ Quick Searches ¥ 7 Add Filter F‘ Save Criteria ‘ Save Results g, Cance

Step 6

Select OK.

To view in ISE, go to Operations > RADIUS > Live Logs.
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You should see the quarantined endpoint designated by the ANC Quarantine Policy:

sl Identity Services Engine

~ Operations » Policy » Administration » Work Centers License Waming A

~RADIUS = Threat-Centric NAC Live Logs  » TACACS » Troubleshoot  » Adaptive Network Control  Reports
Click here to do wireless setup and visibility setup Do not show this again.
Live Logs  Live Sessions
——

[ ] Network Devices @ RADIUS Drops @ Client Stopped Responding & Repeat Counter @
Refresh Never ¥ Show Latest20records % Within Last3 hours $
© Refresh ~ © Reset Repeat Counts & ExportTov Y Filter v o~
Time Status Details Repeat ... Identity Endpoint ID Endpoint P...  Authentication Policy Authorization Policy Authorizati.
X 4 Identity Endpoint ID Endpoint Prof io Auth Authorizatio
Mar 09, 2018 10:59:37.375 PM o a 0 pxgrid1 00:50:56:86:8B:13 Microsoft-W... Default >> Dot1X Default >> ANCQuarantine Quarantined
Mar 09, 2018 10:59:37.261 PM u a pxgrid1 00:50:56:86:BB:13 Microsoft-W... Default >> Dot1X Default >> ANCQuarantine Quarantined
Mar 09, 2018 10:59:36.193 PM Q 00:50:56:86:BB:13

To view in Cisco ISE pxGrid ANC Details Dashboard, go to Cisco ISE pxGrid > ANC Details.

Step 7 You should see the MAC address assigned to the ISE ANC policy name:

€ 4o 2

Admin  Puse  UseCaseMenager  PreMidaon  CisooISE paGid ‘System Time- £:58 pm

ANC Details 2021-07-06 16:47 - 2021-07-07 16:47

Currently Assigned ANC policy

Show[10 v entries
Mac Address . Policy Name
88: 2 pxGridQRadarPortBounce
95:70:26:E4:00:05 policy_demojk-08
95:70:26:E4:00:06 pxGridQRadarPortBounce
95:70:2B:E4:00:07 test_ui
95:70:2B:E4:00:08 testaddition
ASIBD:2T:C2:61:DC pxGridQRadarPortBounce
Fas 3CI58:98 PpxGridQRadarPortBounce
Step 8
Showing 1to 7 of 7 entries Previous E Next

To un-quarantine or clear the endpoint:

Go to ISE > Operations > Adaptive Network Control > Endpoint Assignment.

Identity Services Engine Home  » ContextVisibilty [ERIOTNTUSSN ) Policy  » Administration > Work Centers License Waming 4

» RADIUS  Threat-Centric NAC Live Logs  » TACACS  » Troubleshoot = ~ Adaptive Network Control = Reports
Click here to do wireless setup and visibility setup Do not show this again
Policy List ~ Endpoint Assignment
—e

List
Rows/Page 1 A 1 " Go = 1Total Rows
< Refresh 4 Add T Trash~ Edt  EPS unquarantine Y Fiterv
MAC Address Policy Name Policy Actions
00:50:56:86:8B:13 pxGridQRadarQuarantine [QUARANTINE]
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Select the endpoint MAC address > Trash.

Identity Services Engine Home  » Context Visibility »Policy  » Administration  » Work Centers License Waming &

» RADIUS  Threat-Centric NAC Live Logs  » TACACS  » Troubleshoot = ~ Adaptive Network Control | Reports : - =
Click here to do wireless setup and visibility setu|
Policy List ~ Endpoint Assignment

List

Stel selected Rows/Page | 1 s 1 "

< Refresh <4 Add @ Trash~ @& Edit EPS unquarantine

MAC Address Selected ne Policy Actions

00:50:56:86:BB:13 pxGridQRadarQuarantine [QUARANTINE]

Select Selected, and then you should see:

Are you sure you want to delete selected Item(s)?

@ &

Step 11 Select Yes.

Step 12 In ISE, go to Operations > RADIUS-Live Logs.

You should see that the endpoint has been un-quarantined:

Identity Services Engine Home » Context Visibiiity [EREelENH » Policy » Administration » Work Centers License Waming 4

~RADIUS = Threat-Centric NAC Live Logs  » TACACS  » Troubleshoot  » Adaptive Network Control  Reports
Click here to do wireless setup and visibility setup Do not show this again.
Live Logs  Live Sessions
—

[ ] Network Devices @ RADIUS Drops @ Client Stopped Responding & Repeat Counter @
Refresh Never + Show Latest 20 records + Within Last3 hours T
< Refresh @ ResetRepeatCounts 2 Export Tov Y Filter v - 24
Time Status Details Repeat ... Identity Endpoint ID Endpoint P...  Authentication Policy Authorization Policy Authorizati.
x 4 Identity Endpoint ID Endpoint Prof | | Authentication Policy Authorization Policy Authorizatio
Mar 09, 2018 11:10:33.115 PM . o 0 pxgrid1 00:50:56:86:8B:13 Microsoft-W... Default >> Dot1X Default >> Basic_Authenticat... PermitAcces!
Mar 09, 2018 11:10:32.161 PM a pxgrid1 00:50:56:86:BB:13 Mig ft-W... Default >> Dot1X Default >> Basic_Authenticat... PermitAcces:
Mar 09, 2018 11:10:30.219 PM a 00:50:56:86:BB:13
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Hovering Over IBM QRadar Syslog IP Address for ISE
Contextual Information

Once the endpoint has been authenticated, you can hover the IP address fields and obtain additional
contextual information such as the User Name, Mac Address, Posture Status, and Endpoint Profile.

When you hover over the IP address field, the contextual information is displayed:

IBM QRadar Security Intelligence

Dashboard Offenses QEGLEYSOTIN Network Activity Assets Reports Admin  Cisco pxGrid System Time: 10.07

Search. ¥ Quick Searches ¥ Y Add Fiter | Save Crteris [ Save Resuts o Cancel “\ False Postve Rules ¥V Actions ¥ (7]

ms

2/2/18,4:11 PM-2/18/18, 416 PM v

ke A

eb 10 Feb 11 Feb 12 Feb 13 Feb 14 Feb 15 Feb 16 Feb 17
late Detais
ide Charts.
Destination FramediPAddres: NAS-Port  NASPOt yagipa
Start Time v Low Level Category Source IP Source Port Destination IP Username : Type
Port (custom) (custor
| Misc Login Succeeded 102 168 1 147 | 1845
RADIUS Session Status Network: Net-10-172-192.Net_192_168_0_0 Ethernet
RADIUS Session Ended

UserName:  hostipxGrid2-PC.lab10.com |

gin Succeeded

X Ethernet
ot PXGrid Session details: Mac Address:  00:0C:29.C1782C T
RADIUS Session Started Eus s GO Ethemet

Profile 7
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IBM QRadar Cisco ISE pxGrid Offense Rule

IBM QRadar Custom Rules Engine (CRE) displays the rules and building blocks that are used by IBM
QRadar. The CRE provides information about how the rules are groups, the types of tests that the rules
perform, and the rule responses. A rule is a collection of tests that triggers an action when specific
actions are met.

Offenses are generated when events and flow data pass through the CRE. They are correlated against
the rules that are configured and an offense can be generated based on this correlation and viewed on
the Offenses tab.

The Cisco pxGrid offense rule gets triggered when an event occurs, the match Radius Failure session
or simply three events in the Cisco ISE pxGrid App Failed Authentication Dashboard from the same
source IP address that occur within 10 minutes.

As a simple test, you can attempt to log in with an invalid password, and then login successfully. This
will trigger a failed event followed by a successful login. Repeat this step three or four times within 10
minutes, and this will trigger the IBM QRadar pxGrid Offense rule.

The following image is an example of ISE authentication failure report that confirms failed
authentications.

RADIUS Authentications @
RADIUS Status: Fail

From 2018-03-10 00:00:00.0 to 2018-03-11 00:00:00.0
Generated At: 2018-03-10 02:09:37.37

Logged At RADIUS Status Details  Identity Endpoint ID

2018-03-10 00:58:37.408 (<] Q pxgrid2@lab10.com 00:0C:29:C1:7B:2C
2018-03-10 00:55:37.697 (<] o pxgrid2@lab10.com 00:0C:29:C1:7B:2C
2018-03-10 00:53:10.377 (] Q pxgrid2@lab10.com 00:0C:28:C1:7B:2C
2018-03-10 00:49:49.991 (<] o 00:0C:29:C1:7B:2C
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You can also view events in ISE.

*RADIUS = Theaat-Centic NAC Uve Logs  » TACACS  » Troubleshoot  » Adapive Network Control  Reponts

Cicx Nerw 1 CO wirsiess SeLO an visDaly seup Do ot stmw Tia ag
Lvelogs Live Sessons
———

Mar 10, 2018 015931 302 AM Qo o £ o LAS 1Oomged ¢ mmocecimK & Wroowes” Defautt > Dot1X Dufaut >> Bage Authenticat
Mar 10, 2018 015030 871 AM a Q LA 1 OCwgred ooC2eCr e Wecoms ! Oefnit »» Oot1X Dataut »» Basc_Autherticat
Mar 10, 2018 012906 452 AM a o LAB \Oomgra2 Wroows? Deftautt >> Dot 1X Defaust >» Baso Authenticat
Mar 10, 2018 01:21:15.884 AM ) o 0 Move-Dwvon  Defadt >> Dot1X Detast »» Basc_Authencal
Mar 10, 2098 012116160 AM a o OO CRICH Ao e Owfpt »» Dox1x Owtau »» Basa_ Autherscst
Mar 10, 2018 011BIT.I6T AM ’ o WwoosTeICwN AocreDJwvon Deratt »» VAB Oufat »» Basc Authentcal
Mar 10, 2018 12:50 44 623 AM ﬂ o pegndd@ial 10 com 00OC 9 CY TR Weaows? Dt »» Dot 1 X Onfust »» Basc_ Authenticat
Mar 10, 2018 120042 4680 AW o Q 000C 20T TR X

Mar 10, 2018 125837 408 AM [ ) o pagra2gian 0 com OO 20C1 X ettt »» Dot X Owtast

Mar 10, 2000 128802372 AW a ) hostpeGmad N WoCHCI M W Ostatt »» Dot X Dwfmat »» Baso_ Authendost
Mar 10, 2018 12:57:40 226 AM a o hostpa Gl -AC Wraoes” Detta st »» Dot 1 X Dufaut »> Basc_Autenticat
Mar 10, 2018 120638 688 AM a a pegndd@ral 10 com oC2CI 2 Wrooes ! Ot »>> Dot 1X Defaut »» Basc_Authendcst
Mar 10, 2018 125537 897 AM [} Iy Qe @iab 10 coe oc2¥CI e Ottt »» Dot X Dwtant
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Verify pxGrid offense rule via Log Activity

Go to Log Activity > Add Filter > Parameter > Payload Contains > Operator > is any of > Value >
QRadarAppForPxgrid > "+".

IBM QRadar Security Intelligence

(RPN Network Activity Assets Reports Risks Vulnerablliies Admin Cisco ISE pxGrid

Ste' ————— Qui Y Add F: 4 Rules ¥ Actions ¥
Quick Filter
Viewing real time events View:| Select An Option: |~ Display: Default (Normalized)
Source =
Event Name Log Source Event Count Time Low Level Category Source IP Port Destina
information Message System Notification-2 :: qrad 1 Mar 8, 2018, 8:35:00 nformation 192.168.1.182 0 127.0.0.1
Add Filter
Parameter: Operator: Value:
Payload Contains - is any of v *
[ Payload Contains is QRadarAppForpxGrid
Remove Selected
Add Fitter Cancel
Step 14 .
Select Add Filter.
Step 15

Select View Real Time Events > Last interval setting, for example, 45 minutes.
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IBM QRadar Security Intelligence

[P0 Network Activity Assets Reports Risks Vulnerabllities Admin Cisco ISE pxGrid System Time: 8:38 PM

Search... ¥ Quick Searches ¥ Y AddFilter | Save Criteria [} Save Results g, Cancel %\, False Positive Rules ¥ Actions ¥ (2]

3/9/18, 7:54 PM - 3/9/18, 8:39 PM §

- |

7054 PM 7:56PM 7:58PM 8:00PM 8:02PM B8:04PM B8:06PM B8:08PM 8:10PM 8:12PM 8:14PM 8:16PM 8:18PM B8:20PM B:22PM 8:24PM 826PM 8:28PM 8:30PM B8:32PM B8:34PM B8:36PM B:38PM

Update Details

{Hide Charts)
Event Name Log Source Event Count Time ¥ Low Level Category Source IP S::nros Destination IP Desg:ralﬁc
pxGrid UserSessions pxGrid 1 Mar 9, 2018, 8:29:07...  User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1 . User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1 Marg, 2018, 8:21:06... User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1 Mar9, 2018, 8:16:18... User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1 Mar9, 2018, 8:15:03... User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1 Mar 9, 2018, 8:14:07... User Activity 192.168.1.192 0 192.168.1.192 (]
pxGrid UserSessions pxGrid 1 Mar 8, 2018, 7:59:43... User Activity 192.168.1.192 0 192.168.1.192 0
Search Executed SIM Audit-2 :: gradar2 1 Mar9, 2018, 7:59:37...  SIM User Action 127.0.0.1 0 192.168.1.192 0
fnfj pxGrid Radius Failure pxGrid 1 Mar9, 2018, 7:58:38... User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1 Mar9, 2018, 7:58:11... | User Activity 192.168.1.192 0 192.168.1.192 0
Search Executed SIM Audit-2 :: gradar2 1 Mar 8, 2018, 7:58:00...  SIM User Action 127.0.0.1 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1 . User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1 . User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid Radius Failure pxGrid 1 Mar9, 2018, 7:55:43... User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1 Mar9, 2018, 7:55:24... User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1 Mar 9, 2018, 7:54:48... User Activity 192.168.1.192 0 192.168.1.192 0
pxGrid UserSessions pxGrid 1) Mar 9, 2018, 7:54:12... User Activity 192.168.1.192 0 192.168.1.192 0
Step 16 Click the offense rule @J.
You will see the following:
Offense 1 (All Categories)
Offense 1 @ Summary Display ¥ D Events Connections Flows "7 View Attack Path  Actions ¥ ;'_‘_ Print e
Magnitude Status Relevancel 5 I Severltyl 4 I Credlbllltyl 2
Offense Type | pxGrid_src (custom)
Description | pxGrid Radius Failure EventFl
3 events and 0 flows in 1 categories
count
Source
192.168.1.192 Start Mar 8, 2018, 7:53:10 PM
IP(s)
Destination
192.168.1.182 Duration 5m 27s
IP(s)
Network(s) | Net-10-172-192.Net 192 168 0 0 Assigned to | Unassigned
Offense Source Summary
Custom property value| 192.168.1.60
Offenses 1 Events/Flows| 1
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Verify pxGrid offense rule via Offenses Dashboard

After select Offenses, you should see the pxGrid Radius Failure Offense rule:

IBM QRadar Security Intelligence

Dashboard Qe CLETTE Log Activity Network Activity Assets Reports Risks Vulnerablliies Admin  Cisco ISE pxGrid

Offenses Search.. ¥ | Save Criteria  Actions ¥ (=3, Print Last Retresh: 00:0000 Il X @

My Offenses

All Offenses  View Offenses: Select An Option: :
Al Orfenses. Current Search Parameters:
By Category Exclude Hidden Offenses (Clear Filter), Exclude Closed Offenses (Clear Filter)
By Source IP G A ] Description Offense Type Offense Source Magnitude Source IPs Destination IPs Users Log Sources
1 pxGrid Radius Failure pxGrid_src (... 192.168.1.60 192.168.1.192 192.168.1.192 N/A pxGrid
By Destination IP
By Network
Rules

Taking ISE ANC mitigations from Offenses Dashboard

Under the Offense Source, right-click the IP address, and then select the Cisco pxGrid - ANC
Step 1 Quarantine mitigation action.

IBM QRadar Security Intelligence

Log Activity Network Activity Assets Reports Risks Vulnerabliiies Admin Cisco ISE pxGrid

Offenses Search... ¥ |5 Save Criteria  Actions ¥ 4, Print Last Retresh:00:00:10 Il 2@ @
My Offenses
All Offenses  View Offenses: Select An Option: -
AllOffenses Current Search Parameters:
By Category Exclude Hidden Offenses (Clear Filter), Exclude Closed Offenses (Clear Filter)
By Source IP S Id Description Offense Type Offense Source Magnitude Source IPs Destination IPs Users Log Sourct
(piGrdRadusFale | pGrdsro(..| 182108 121061102 |NA _|pcrid |
By Destination IP -_ { _ Navigate > -
Information >
By Network
Run Vulnerability Scan
Rules Run Forensics Recovery
Run Forensics Search
Plugin options... >
Ste| . Cisco pxGrid - ANC Quarantine
. Cisco pxGrid - ANC Shutdown
. Cisco pxGrid - ANC Port Bounce

This will trigger the ANC Quarantine:

IBM QRadar Security Intelligence 192.168.1.192 Says

Dashboard e, CHEL ANC action returned status: RUNNING

Offenses Search... ¥ H Save Criteria Actions ¥ : Print L OK b

My Dffences

Select OK.
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In ISE, select Operations > RADIUS > Live Logs.

The endpoint has been quarantined as designated by the ANC Quarantine
Authorization Policy.

bl Identity Services Engine Home  » Context Visibiity

Threat-Centric NAC Live Logs  » TACACS

v Operations » Policy

» Administration » Work Centers
~RADIUS

License Waming 4
» Troubleshoot  » Adaptive Network Control

Reports . Z SR
Click here to do wireless setup and visibility setup Do not show this again.
S Live Logs  Live Sessions
=] L

< Refresh © Reset Repeat Counts 2 ExportTov Y Fitter v - 24
Time Status Details Repeat ... Identity Endpoint ID Endpoint P...  Authentication Policy Authorization Policy Authorizati.

X Identity Endpoint 10 Endpoint Profi Authentication Policy Authorization Policy Authorizatio
Mar 10, 2018 02:30:00.432 AM o o 0 LAB10\pxgrid2 00:0C:298:C1:7B:2C Windows7-... Default >> Dot1X Default >> ANCQuarantine Quarantined.
Mar 10, 2018 02:30:00.145 AM Q LAB10\pxgrid2 00:0C:29:C1:78:2C Windows7-... Default >> Dot1X Default >> ANCQuarantine Quarantined.

To un-quarantine or clear, go to Operations > Adaptive Network Control > Endpoint Assignment.

Home » Context Visibliity
» RADIUS  Threat-Centric NAC Live Logs

~ Operations » Policy
» TACACS » Troubleshoot

» Administration » Work Centers

~ Adaptive Network Control = Reports
Policy List  Endpoint Assignment

List

< Refresh =+ Add M Trash~ Edit EPS unquarantine

MAC Address Policy Name

Policy Actions
00:0C:29:C1:7B:2C pxGridQRadarQuarantine [QUARANTINE]
Step 6

Select the endpoint > Trash.

ubub.  |dentity Services Engine

Home » Context Visibility

~ Operations » Policy

» Administration
» RADIUS Threat-Centric NAC Live Logs  » TACACS  » Troubleshoot =~ Adaptive Network Control | Reports
Policy List  Endpoint Assignment
List
1 Selected

2 Refresh <4 Add T Trash~v @& Edit  EPS unquarantine

MAC Address Selected ne Policy Actions

00:0C:29:C1:7B:2C prridQRadarQuarann‘ne [QUARANTINE]
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Select > Selected.

Are you sure you want to delete selected Item(s)?

Ste

Select Yes.

In ISE, you should see the endpoint has been un-quarantined:

Ste|
[ i Identity Services Engine Home  » ContextVisibity PRRS il *Policy »Administration  » Work Centers License Waming 4

~RADIUS | Threat-Centric NAC Live Logs  » TACACS  » Troubleshoot  » Adaptive Network Control  Reports % E ey 7
STE\ Click here to do wireless setup and visibility setup Do not show this again.

Live Logs  Live Sessions
—

[: ] Network Devices & RADIUS Drops & Client Stopped Responding & Repeat Counter @
0 0 12 5 0
Refresh Never ¥ Show Latest20 records 5 Within Last3 hours v

© Refresh @ Reset Repeat Counts & Export Tov Y Filter» - 24

Time Status Details Repeat ... Identity Endpoint ID Endpoint P... Authentication Policy Authorization Policy Authorizati.
o) ] Identity Endpoint ID Endpoint Profi | | Authentication Policy Authorization Policy Authorizatio

Mar 10, 2018 02:39:09.036 AM [ ] Qa 0 LAB10\pxgrid2 00:0C:28:C1:78:2C Windows7-... Default >> Dot1X Default >> Basic_Authenticat... PermitAcces:

Mar 10, 2018 02:39:01.704 AM a 00:0C:29:C1:7B:2C

Step 10
Select Dashboard

IBM QRadar Security Intelligence

PECLLLEIGE Offenses  Log Activity Network Activity Assets Reports Risks Vulnerablliies Admin  Cisco ISE pxGrid

Show Dashboard:| Threat and Security Monitoring %! []New Dashboard [ Rename Dashboard () Delete Dashboard  Add ltem... ¥ Next Refresh: 00:00:50 Il & @)
Default-IDS / IPS-All: Top Alarm Signatures GCEE My Offenses (& x| Flow Bias (6 % X

No results were returned for this item.

Most Severe Offenses o8
Offense Name Magnitude
There was no Time Series data for the search performed. pxGrid Radius Failure There was no Time Series data for the search performed.
Most Recent Offenses @8
Offense Name Magnitude
pxGrid Radius Failure
Top Services Denied through Firewalls |15 3 x|
View in Log Activity, View in Network Activity.
Top Systems Attacked (IDS/DP/IPS) 6 8 X Top Category Types E8
Ste Category Offenses
User Activity 1
Object Not Cached 0
There was no Time Series data for the search performed. Rate Limitin 0
No Rate Limiting 0
Object Cached 0
There was no Time Series data for the search performed.
Top Sources 8
Source Offenses
192.168.1.192 1

Select pxGrid Radius Failure.
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Hover over the Offense Source IP Address.

IBM QRadar Security Intelligence

Log Activity Network Activity Assets Reports Risks Vulnerabilites Admin Cisco ISE pxGrid

Offenses Search.. ¥ || Save Criteria  Actions ¥ (&3, Print Last Rotresn: 000015 Il > @

My Offenses

S te| All Offenses  View Offenses: Select An Option:
Alloffenzes Current Search Parameters:

Exclude Hidden Offenses (Clear Filter), Exclude Closed Offenses (Clear Filter)

«

By Category
By Source IP 7 Id Description Offense Type Offense Source Magnitude Source IPs Destination IPs Users Log Sourei
[ [ [pxrd Radus Feure 1. XX A Tpid |
By Destination IP Network: Net-10-172-192.Net_192_168_0_0
By Network User Name:  LAB10\pxgrid2
pxGrid Session detalls: Mac Address:  00:0C:29:C1:78:2C
Rules Posture Status: None

Endpoint Profile: Windows7-Workstation

Right click for more information on 192.168.1.60

Cisco Systems © 2021 Page 95



ST
SECURE ACCESS HOW-TO GUIDES cISCOo

Addendums

Adding Log Activity Filter to View Session Information

In this section, a pxGrid app filter is created to view the incoming session information.

Select Log Activity > Add Filter > Select the following:

IBM QRadar Security Intelligence

[P0V Network Activity Assets Reports Admin  Cisco ISE pxG...

Ste)
s v ¥ 4 savec 3 v v 1
Advanced Search Search
Viewing real time events View:| Select An Option - Display: | Default (Normalized)
" rce "
Event Nam) Add Filter n Destina
Parameter: Operator: Value:
Log Source [Indexed]  ~ Equals ~ | Log Source Filter:| Type to Filter
" SIM Generic Log DSM-7 :: gradar3
Search Results-2 :: gradar3
Log Source: System Notification-2 :: qradar3
Threecom8800SeriesSwitch @ 127.0.0....
pxGrid
Add Filter Cancel
Step 2

Add the following search criteria:

SELECT "pxGrid_adNormalizedUser" AS 'label' , COUNT("pxGrid_adNormalizedUser") AS 'value' FROM
Step 3 events WHERE LOGSOURCENAME(logsourceid)="pxGrid' AND "pxGrid_EventName"='User Sessions' GROUP

BY "pxGrid_adNormalizedUser" ORDER BY value DESC LIMIT 10 LAST 1 DAYS
Step 4

Click Search.

You should see the Cisco ISE pxGrid User Sessions.

IBM QRadar Security Intelligence

Dashboard Offenses EELPX-OVIN Network Activity Assets Reports Admin Cisco ISE pxG...

Search... ¥ Quick Searches ¥ Ny Add Filter | Save Criteria [ Save Results g, Cancel %, Faise Positive Rules ¥  Actions ¥

Advanced Search ~ | ceid)="pxgrid' AND "pxGrid_EventName"='User Sessions' GROUP BY "pxGrid_adNormalizedUser" ORDER BY value DESC LIMIT 1@ L

Viewing real time events View: Select An Option: | ~ Display: | Default (Normalized) @ ~

Current Filters:
Log Source is pxGrid (Clear Filter)

Event Name Log Source et Time Low Level Category Source IP Source  pestina
Cisco ISE pxGrid User Sessions pxGrid 1 Apr 19, 2019, 6:24:1... User Activity 169.254.2.2 (4] 169.254.]
Cisco ISE pxGrid User Sessions pxGrid 1 Apr 19, 2019, 6: . User Activity 169.254.2.2 0 169.254.)
Cisco ISE pxGrid User Sessions pxGrid 1 Apr 19, 2019, . User Activity 169.254.2.2 0 169.254.,
Information Message System Notification-2 :: grad... 1 Apr 19, 2019, . Information 192.168.1.249 ) 127.0.0.1
User Logout SIM Audit-2 :: gradar3 1 Apr 19, 2019, 6: . SIM User Authentication 169.254.2.2 o 192.168.
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Using an External Certificate Authority

This section illustrates generating certificates for the IBM QRadar pxGrid App, using the ISE internal CA.
It is assumed that the ISE pxGrid node and the other ISE nodes are signed by an external CA server. In
this example, there are two ISE instances. The ISE26.1ab20.com node is the primary ISE instance, and
contains the Primary Admin, Primary MNT, Primary pxGrid node, and PSN personas.

The ISE26ca.lab10.com node is the secondary ISE instance, and contains the Secondary Admin,

Secondary MNT, Secondary pxGrid, and PSN personas.
Verify that the ISE pxGrid, the ISE Admin and ISE MNT nodes are signed by the external CA

Step 1

Server.

Go to Administration > System > Certificate > System > Certificates > System Certificates.

The ISE pxGrid and ISE Primary Admin nodes are signed by an external CA Server.

il Identity Services Engine

Steg

v System

Deployment

Home

» Context Visibility

» Identity

Licensing

~ Certificate Management

System Certificates
Trusted Certificates
OCSP Client Profile

Certificate Signing Requests

Certificate Periodic Check Setti...

» Certificate Authority

» Network

v Certificates
B

System Certificates

» Logging

Friendly Name

V ise26

OU=Certificate Services
System Certificate, CN=i
se26.lab10.com#Certific
ate Services Endpoint S
ub CA - ise26#00002
Default self-signed saml|
server certificate - CN=S
AML_ise26.1ab10.com

CN=ise26.lab10.com#la
b10-WIN-N3OR1TATHIK
L-CA#00003

OU=ISE Messaging Ser
vice,CN=ise26 .1ab10.co
m#Certificate Services E
ndpoint Sub CA - ise26#
00001

» ise26ca

Verify the pxGrid and Admin

» Maintenance

» Operations

» Device Portal Management

Upgrade

" Edt |4 Generate Self Signed Certificate

Used By

Not in use

SAML

Admin, Portal
EAP
Authentication
pxGrid,
RADIUS DTLS

ISE Messaging
Service

» Policy
pxGrid Services

» Backup & Restore

i Import | & Export

Portal group tag

Default Portal Certificate
Group (i

» Admin Access

v Administration

» Feed Service

XK Delete || J) View

Issued To

ise26.lab10.com

SAML_ise26.lab10,com

ise26.lab10.com

ise26.lab10.com

» Settings

» Threat Centric NAC

Issued By

Certificate Services Endp
oint Sub CA - ise26

SAML _ise26.lab10.com

lab10-WIN-N3OR1A7HS
KL-CA

Certificate Services Endp
oint Sub CA - ise26

Click here to do wireless setup Do not show

For disaster recovery it is recommended to export certificate and private key pairs of all system certificates.

Valid From

Tue, 5 Mar 2019

Wed, 6 Mar 2019

Sat, 23 Mar 2019

Tue, 5 Mar 2019

certificates are signed by the external CA server.
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Expiration Date

Tue, 6 Mar 2029

Thu, 5§ Mar 2020

Tue, 23 Mar 202

Tue, 6 Mar 2024
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vl
cisco

Identity Services Engine

Home » Context Visibility » Operations » Policy » Work Centers License Waming A Q

Step 3

wltln
cisco

~System  » Identity » R » Device Portal Management  pxGrid Services  » Feed Service  » Threat Centric NAC
Click here to do wireless setup Do not show 1l
Deployment  Licensing ~Certificates » Logging » Maintenance Upgrade » Backup & Restore  » Admin Access  » Settings
—
o
~ Certificate Management System Certificates /, For disaster recovery it is to export and private key pairs of all system certificates.
System Certificates J/ Edit || Generate Self Signed Certificate | = Import | & Export X Delete  JJ View
Trusted Certificates Friendly Name Used By Portal group tag Issued To Issued By Valid From Expiration Date
OCSP Client Profile <
Certificate Signing Requests = Bn2fos
i ues
gl Default self-signed saml
Certificate Periodic Check Sett. .. server certificate - CN=S SAML SAML_ise26lab10.com SAML_ise26.lab10.com Wed, 6 Mar 2019 Thu, 5 Mar 2020
AML_ise26.1ab10.com
» Certificate Authority Default self-signed sam| » . b
server certificate - CN=S  Not in use iAML JaeZfcaan10.% :‘AML" Rerien)0.. Wed, 6 Mar 2019 Thu, 5 Mar 2020
AML_ise26ca. lab10.com
Admin, Portal,
CN=ise26ca.lab10.com# EAP
lab10-WIN-NSORTATHO  Authentication,  ero - orial Cortficale 7604 tab10.com UG IN-NIORIATHS e, 6 Mar 2019 Sat, 6 Mar 2021
KL-CA#00003 pxGrid, il
RADIUS DTLS
OU=Certificate Services
System Certificate, CN=i
se26ca.lab10.com#Certif Certificate Services Endp
Fi Tue, 6 Mar 2029
icate Services Endpoint Not in use ise26ca.lab10.com oint Sub CA - ise26ca rl, 22 Mar 2019
Sub CA - ise26ca#0000
4
OU=ISE Messaging Ser
vice,CN=ise26ca.lab10.c
> ISE Messaging Certificate Services Endp Tue, 6 Mar 2029
om#Certificate Services Service ise26ca lab10.com oint Sub CA - Ise28 Frl, 22 Mar 2019 ue,

Ensure that the published pxGrid nodes appear and you

Endpoint Sub CA - ise26
ca#00004

Go to Administration > pxGrid Services.

Now, you see the following:

Identity Services Engine

Home » Context Visibility

» Operations » Policy

v Administration

» Work Centers

have pxGrid node connectivity:

License Waming 4

» System  » Identity » N R » Device Portal Management = pxGrid Services = » Feed Service  » Threat Centric NAC
Click here to do wireless setup Do not show Ul
All Clients Web Clients Capabilities Live Log Settings Certificates Permissions
—
o/ Enable (@) Disable QAppmve © Group ‘ Decline em v Qﬂeﬁ& Total Pending Approval(0) « 1-180f18 Show 25 v perpage Page [
0O Client Name Description Capabilities Status Client Group(s) Auth Method
[0 » ise-fanout-ise26 Capabilities(0 Pub, 0 Sub) Online (XMPP) Internal Certificate
[0 » ise-mnt-ise26ca Capabilities(2 Pub, 1 Sub) Online (XMPP) Internal Certificate
[J » ise-pubsub-ise26ca Capabilities(0 Pub, 0 Sub) Online (XMPP) Internal Certificate
[0 » ise-admin-ise26ca Capabilities(1 Pub, 1 Sub) Online (XMPP) Internal Certificate
[J » ise-fanout-ise26ca Capabilities(0 Pub, 0 Sub) Online (XMPP) Internal Certificate
[0 » ise-bridge-ise26 Capabilities(0 Pub, 4 Sub) Online (XMPP) Internal Certificate
[0 » ise-admin-ise26 Capabilities(4 Pub, 2 Sub) Online (XMPP) Internal Certificate
[J » ise-pubsub-ise26 Capabilities(0 Pub, 0 Sub) Online (XMPP) Internal Certificate
[0 » wsal.lab10.com_start_test 613 ISED Capabilities(0 Pub, 0 Sub) Offline (XMPP) Certificate
[0 » wsal.lab10.com613 ISED Capabilities(0 Pub, 0 Sub) Offline (XMPP) Certificate
Step g » wsat.labi0.comds7 ISED Capabilities(0 Pub, 0 Sub) Offline (XMPP) Certificate
[J » wsal.lab10.com498 ISED Capabilities(0 Pub, 0 Sub) Offline (XMPP) Certificate
[J » wsal.lab10.com315 ISED Capabilities(0 Pub, 0 Sub) Offline (XMPP) Certificate
[J » firesightisetest-fmc63.lab10.com-... Capabilities(0 Pub, 0 Sub) Offline (XMPP) Certificate
[J » gradar6 pXGrid App for Qradar Capabilities(0 Pub, 0 Sub) Offline (XMPP) ANC Certificate
[J » iseagent-fmc63.lab10.com-285faf... GCL for C sample Capabilities(0 Pub, 0 Sub) Offline (XMPP) Certificate
M1 »  aradtoct Canahilitioc/N Dith N Ciih) Nfflina ('YMDDY Cartifirato

Ensure that there is pxGrid connectivity. If in the lower-left corner you see "no connectivity",
there is a certificate issue with the ISE pxGrid node, the ISE admin and MNT nodes.
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Generating IBM QRadar Certificate from ISE Internal CA

In this example, the certificate is generated for the IBM QRadar instance using the ISE Internal CA. You
can also use opens to create the private key, generate a Certificate Signing Request (CSR), and get this
signed by the same customized template that was used for the ISE pxGrid node. To summarize, the
customized template must have an EKU of both client and server authentication.

Create and generate certificate for the IBM QRadar instance:

Go to Administration > pxGrid Services > Certificates.

‘dses’ Identity Services Engine Home  » ContextVisbilty  » Operations  » Policy [N i License Waming &

Ste

» System  » Identity Management  » Network Resources  » Device Portal Management = pxGrid Services = » Feed Service  » Threat Centric NAC
Click here to do wireless setup Do not shg

All Clients Web Clients Capabilities Live Log Settings Certificates Permissions
ey

Generate pxGrid Certificates

Iwantto *
Common Name (CN) *

Certificate Template pxGrid_Certificate_Template @

Subject Alternative Name (SAN) =
Certificate Download Format * )
Certificate Password * o

Confirm Password *

Reset

Connected via XMPP ise26.lab10.com (standby: ise26ca)

Ste|

Step 3
From the | want to list, select Generate a single certificate without a signing request.

S . .

tep 4 In the Common Name (CN) box, enter the Fully Qualified Domain Name (FQDN) of the QRadar

Instance.

Step 5

Step 6 From the Subject Alternative Name (SAN) list, select the IP Address, and then enter the IP

Step 7 address of the QRadar instance.

Provide a description name.
From the Certificate Download Format list, select the PEM format.

In the Certificate Password box, enter the encryption password.
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In the Confirm Password box, enter the password once again.

‘dsey Identity Services Engine Home  » ContextVisbity  » Operations  » Policy T IUE  » Work Centers License Warning 4

» System  » |dentity Management  » Network Resources  » Device Portal Management = pxGrid Services = » Feed Service  » Threat Centric NAC : N
Click here to do wireless setup Do not show t|

All Clients Web Clients Capabilities Live Log Settings Certificates Permissions
————————

Generate pxGrid Certificates

Ste|
I wantto * Generate a single certificate (without a certificate signing request) v
Common Name (CN) * Qradar3.lab10.com
Description Qradar Instance
Certificate Template pxGrid_Certificate_Template @
Subject Alternative Name (SAN) IP address % 192.168.1.249
Certificate Download Format * Certificate in Privacy Enhanced Electronic Mail (PEM) format, key in PKCS8 PEM format (including certificate chain) 4 @
Certificate Password *  sesesess o
Confirm Password *  sessssad|
Connected via XMPP ise26.lab10.com (standby: ise26ca)
Step 9 Select Create.
Step 10

Copy the zipped file into a folder and unzip the files:

L CertificateServicesEndpointSubCA-ise26_.cer
| CertificateServicesNodeCA-ise26_.cer
| CertificateServicesRootCA-ise26_.cer
| lab10-WIN-N3OR1A7HIKL-CA_.cer
Step 11 __J Qradar3.lab10.com_192.168.1.249.cer
Qradar3.lab10.com_192.168.1.249.key

Unencrypt the QRadar private key:

Copy the original QRadar .key file to QRadar.key.org file:

cp QRadar3.labl1@.com_192.168.1.249.key QRadar3.labl@.com_192.168.1.249.key.org

Note:
Then, run openness to remove the encryption password from the key.org file. You will get an

unencrypted file as defined by the -out parameter. The unencrypted key will be the .key file.

QRadar3.labl@.com_192.168.1.249.key.org -out QRadar3.labl@.com_192.168.1.249.key Enter pass
phrase for QRadar3.labl@.com_192.168.1.249.key.org:(enter passphrase used when generating
certificate) writing RSA key

Open SSL is on most Linux and MAC operating systems.
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To download the certificate root chain:

Go to Administration > pxGrid services > Certificates.

License Waming A

» Operations » Policy ~ Administration » Work Centers

‘dsts' Identity Services Engine Home  » Context Visibiity
» Network Resources  » Device Portal Management

» System  » Identity Management pxGrid Services ~ » Feed Service  » Threat Centric NAC
Click here to do wireless setup Do not show

Ste|
All Clients Web Clients Capabilities Live Log Settings Certificates Permissions
Generate pxGrid Certificates
Iwantto * Download Root Certificate Chain
Host Names *
Certificate Download Format * Certificate in Privacy Enhanced Electronic Mail (PEM) format, key in PKCS8 PEM format (including certificate chain) ¢ @
Connected via XMPP ise26.lab10.com (standby: ise26ca)
From the | want to list, select Download Root Certificate Chain.
Step 13 .
In the Host Names box, select the ISE PAN Nodes:

Step 14
» Operations » Policy v Administration » Work Centers License Waming &

“luiln - dentity Services Engine Home » Context Visibility

cisco
» Feed Service  » Threat Centric NAC
Click here to do wireless setup Do not show 1|

» System  » Identity Management » Device Portal Management = pxGrid Services

» Network Resources

All Clients Web Clients Capabilities Live Log Settings Certificates Permissions

Generate pxGrid Certificates

Iwantto* Download Root Certificate Chain

Host Names * *ise26 | | xise26ca | |

Certificate in Privacy Enhanced Electronic Mail (PEM) format, key in PKCS8 PEM format (including certificate chain) &

Certificate Download Format *

Ste|
Step (l:o‘:\nected via XMPP ise26.lab10.com (standby: ise26ca)
Step 17 From the Certificate Downloaded Format list, select PEM format.
Select Create.
Download the zipped file into the same folder where you downloaded the QRadar certificate
Step 18 zipped files. Now, you see the following files:

| ise26.1ab10...68.1.133.cer
| Ise26ca.lab10.com_.cer
. lab10-WIN-..HOKL-CA_.cer

Create a new folder, for example, QRadar_all_certs.
Then, copy the ISE identity certificates, for example, ise26.lab10.cer and ise26ca.lab10.com,
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the QRadar certificate key-pair files, the external root CA, and the ISE certificate files into this

new folder.
0 1555267694713 _cert > CertificateServicesEndpointSubCA-ise26_.cer
I 155526769471 3_cert.zip CertificateServicesNodeCA-ise26_.cer
© 1555269751612 _cert » CertificateServicesRootCA-ise26_.cer
I 155526975161 2_cert.zip ise26.l1ab10.com_192.168.1.133.cer

BB gradar_all_certs > ise26ca.lab10.com_.cer

lab10-WIN-N3OR1A7HOKL-CA_.cer
Qradar3.lab10.com_192.168.1.249.cer
' Qradar3.lab10.com_192.168.1.249.key

Please DO NOT copy the encrypted key.org file into the new folder.

Note:
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Troubleshooting

Cisco ISE pxGrid App pxGrid client not showing under ISE pxGrid Client View

If using an external CA server, upload the CA root certificate and include it in Root CA Certificate file
name.

Cisco ISE pxGrid App pxGrid client not showing under ISE pxGrid Web Client View
Ensure that both the IBM QRadar SIEM and the Cisco ISE pxGrid node are FQDN are resolvable.

Make sure the Forward and Reverse DNS for ISE is defined on the network, And FQDN is resolvable
completely from QRadar.
Troubleshoot inside QRadar:

Take an SSH to the PxGrid Docker Container on Qradar.
For QRadar versions 7.3.3 and above run the commands:

2. 1> /opt/qradar/support/recon ps
2> /opt/qradar/support/recon connect <App ID>

Cisco ISE pxGrid Dashboards not populating with ISE Contextual Information

Ensure that the Cisco ISE pxGrid App appears under the ISE pxGrid Web Client View.

Using the IBM QRadar pxGrid App Logs for Troubleshooting

The QRadar app logs are used for troubleshooting the connection between the QRadar pxGrid App and
the ISE pxGrid node.

Stepdr example, if the QRadar pxGrid client does not appear under the ISE pxGrid Clients View, you can
view the QRadar app log to see if the secure web socket connection is established between the QRadar
app and the ISE pxGrid node.

To see the QRadar apps, type the following:
[root@QRadar3 support]# /opt/qradar/support/recon ps

Step 2
PORT  CONTAINER IMAGE STATUS appID NAME
32768 28ac62f3a3d8 2cabd65ea8554650b3990bbdd83159d8 RUNNING 1201 Cisco ISE
pxGrid

Use Recon connect to retrieve the container contents:
[root@QRadar3 support]# /opt/qradar/support/recon connect <<appID>> bash-4.1# 1s
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App Dev home 1ib64 opt root selinux start_container.sh Sys Usr
Bin etc init media proc run.py src_deps start_flask.sh Tmp var
boot executeapp.bat 1lib mnt gpython sbin srv store upgradePath.sh

For QRadar versions 7.3.2 and above, run the commands:
1> /opt/qradar/support/recon ps

2> /opt/qradar/support/recon connect <App ID>
Note: Use tail to view the app.log: bash-4.1# tail -f store/log/app.log

A successful connection will look like this:

2019-04-14 21:14:43,812 [abstract_gpylib.log] [Thread-1] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Primary Server: ise26.labl10.com 2019-04-14 21:14:43,812
Step 3 [abstract_gpylib.log] [Thread-1] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Secondary Server: 192.168.1.138

2019-04-14 21:14:43,813 [abstract_gpylib.log] [Thread-1] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Current Active Server: primary

2019-04-14 21:14:48,933 [abstract_gpylib.log] [Thread-1] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Account Activation Status: 200

2019-04-14 21:14:48,933 [abstract_gpylib.log] [Thread-1] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Performing service lookup for:com.cisco.ise.pubsub

19-04-14 21:14:49,280 [abstract_qgpylib.log] [Thread-1] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Creating WebSocketClient....

2019-04-14 21:14:49,282 [abstract_gpylib.log] [Thread-1] [INFO] - 127.0.0.1

[APP_ID/1201][NOT : 0000006000 ]

Connecting to websocket

2019-04-14 21:14:49,321 [abstract_gpylib.log] [Thread-1] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Connected and about to running for ever....

2019-04-14 21:14:49,322 [abstract_gpylib.log] [WebSocketClient] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Subscribe request sent to websocket for

/topic/com.cisco.ise.session

2019-04-14 21:14:49,322 [abstract_gpylib.log] [WebSocketClient] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Subscribe request sent to websocket for

/topic/com.cisco.ise.radius.failure

2019-04-14 21:14:49,323 [abstract_gpylib.log] [WebSocketClient] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Subscribe request sent to websocket for

Note: /topic/com.cisco.ise.config.anc.status

2019-04-14 21:14:49,324 [abstract_gpylib.log] [WebSocketClient] [INFO] - 127.0.0.1

[APP_ID/1201][NOT:0000006000] Subscribe request sent to websocket for

/topic/com.cisco.ise.mdm.endpoint

Step 4
You should see a successful connection to the primary server connection and an
activation status. You should also see a subscription to the pxGrid topic over a secure
Websockets connection. Please disregard the *crypto messages and the unauthorized
messages.

If you do not see a successful connection where there is no Primary server response, or the

connection keeps switching between the primary and secondary pxGrid nodes, this can be an
indication that some of the services have not started or may be in an inconsistent state.
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Step 5

Step 6

Step 7

Step 8

omH LN -

2019-04-14 20:20:57,799 [abstract_gpylib.log] [Thread-100] [INFO] - 127.0.0.1
[APP_ID/1201][NOT:0000006000] Primary Server Response: None

2019-04-14 20:22:08,369 [abstract_gpylib.log] [Thread-103] [INFO] - 127.0.0.1
[APP_ID/1201][NOT:0000006000] Received request to test primary files

2019-04-14 20:22:08,374 [abstract_gpylib.log] [Thread-103] [INFO] - 127.0.0.1
[APP_ID/1201][NOT:0000006000] Trying http connection .................. 2019-04-14 20:22:13,380
[abstract_gpylib.log] [Thread-103] [INFO] - 127.0.0.1 [APP_ID/1201][NOT:0000006000] Wraping SSL
SOEYP  600000000000600000

You can stop or restart your app by using the IBM QRadar GUI Application Framework REST API
endpoints. As a reference, see this page.

Stop the pxGrid App:

POST /api/gui_app_framework/applications/{app_id}?status="STOPPED"

Start or restart the pxGrid app:
Start the app: POST /api/gui_app_framework/applications/{app_id}?status="RUNNING"
Restart the app:

Copy the PxGrid app ID: ssh to QRadar >> /opt/qradar/support/recon ps.

In the GUI, open the QRadar Menu bar.

Click the Interactive API for Developer.

Click the drop button of the latest version >>gui_app_framework>>applications>>application_id.
Under POST, enter the application_id.

Update the status to STOPPED, then RUNNING, to stop and start the app.

Review the QRadar app log again or check to see if the pxGrid client appears under Web Clients
on the ISE pxGrid node view.

If you are stuck in the loading page, click Reset and change the date, to reflect a day before and
a day after. There should be real-time authentications in ISE, so the session information can be
seen in the IBM QRadar App.

Here are some more log issues with connectivity:

pxGrid a

In ord
check the box to automatically approve certificate based connections. This is entirely up to the

Note:

pp pendingj state in th Iogs due to ISE pxGrid client not bseingsgpproved.

to ‘automatically approve, for futur® connections you can allow under pxGrid > Settin

ThisMMMnngd@i&mdaml&&gkﬁdaa@pSas@mwmghéﬁew caneseerthitstunder admin > pxGrid > All
Clief [SFUsEH M Y LS RETRE BB ML EEY under Web Clients as it hasn’t been approved. You can

manually approve it in the All clients page (this was noted in the setup section of the guide).

2021-02-02 17:35:00,088 [abstract_gpylib.log] [Thread-740] [INFO]
- 127.0.0.1[APP_ID/1102][NOT:0000006000] Checking response got from primary server
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2021-02-02 17:35:00,088 [abstract_qgpylib.
- 127.0.0.1[APP_ID/1102][NOT:0000006000 ]

2021-02-02 17:35:00,088 [abstract_gpylib.

- 127.0.0.1[APP_ID/1102][NOT: 0000006000 ]

{"accountState":"PENDING",

version":

After its connected.

2021-02-02 20:40:00,097 [abstract_qgpylib.
- 127.0.0.1[APP_ID/1102][NOT:0000006000 ]

{"accountState":"ENABLED","version":"

2.0.

2.0.

log] [Thread-740] [INFO]

Checking status from primary server: 200
log] [Thread-740] [INFO]

Checking response from primary server:
3.14"}

log] [Thread-1193] [INFO]
Checking response from primary server:
3.14"}

Not able to connect to ISE node from QRadar ISE pxGrid app.

These logs were seen when pointing Qradar ISE pxGrid app to the admin node of ISE (should be

pointing to a pxGrid node).

2021-02-02 17:20:04,148 [abstract_gpylib.
- 127.0.0.1[APP_ID/1102][NOT:0000006000 ]
2021-02-02 17:20:04,148 [abstract_gpylib.
- 127.0.0.1[APP_ID/1102][NOT:0000006000 ]
2021-02-02 17:20:04,148 [abstract_qgpylib.
- 127.0.0.1[APP_ID/1102][NOT:0000006000 ]
2021-02-02 17:20:04,191 [abstract_qgpylib.
- 127.0.0.1[APP_ID/1102][NOT:0000003000]
'exceptions.ValueError'>

2021-02-02 17:20:04,191 [abstract_gpylib.

- 127.0.0.1[APP_ID/1102][NOT:0000003000 ]
object could be decoded

2021-02-02 17:20:04,191 [abstract_gpylib.
- 127.0.0.1[APP_ID/1102][NOT:0000003000]
'exceptions.ValueError'>

2021-02-02 17:20:04,192 [abstract_gpylib.
- 127.0.0.1[APP_ID/1102][NOT:0000003000]
object could be decoded

2021-02-02 17:25:00,032 [abstract_qgpylib.
- 127.0.0.1[APP_ID/1102][NOT: 0000006000 ]
2021-02-02 17:25:00,036 [abstract_qgpylib.
- 127.0.0.1[APP_ID/1102][NOT: 0000006000 ]

log] [Thread-707] [INFO]

Client Name Jabe02022021

log] [Thread-707] [INFO]

URL /pxgrid/control/ServicelLookup

log] [Thread-707] [INFO]

Service Name com.cisco.ise.pubsub

log] [Thread-707] [ERROR]

Exception reported from invoke_cisco _ws_api method: <type

log] [Thread-707] [ERROR]
Exception reported from invoke_cisco_ws_api method: No JSON

log] [Thread-707] [ERROR]
Exception reported from subscribefromwebsocket method: <type

log] [Thread-707] [ERROR]
Exception reported from subscribefromwebsocket method: No JSON

log] [Thread-718] [INFO]

Checking http connection with primary server

log] [Thread-718] [INFO]

Checking connection with primary server using PROTOCOL_SSLv23
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TCP Dump to Analysis Failed Certificate Exchange in ISE

In this section, we are going to see how we can download .pcap file for analysis from ISE, in case the
certificate exchange fails, or the Client is not subscribing to topics.

Navigate to Operation > Troubleshoot > Diagnostic Tools > TCP Dump.

From the Format drop-down list, select the Raw Packet Data, and then click Start.

“Hseh:  Identity Services Engine Home » Context Visibility ~ Operations » Policy » Administration » Work Centers

» RADIUS  Threat-Centric NAC Live Logs  » TACACS @ ~Troubleshoot | » Adaptive Network Conirol  Reporis

Ste| < x
v Diagnostic Tools  Download Logs
[r——.——

(<]
~ General Tools TCP Dump
RADIUS Authentication Troublesht Monitor the packet headers on the network and save to a file (up to 5 Minutes)
Execute Network Device Comman Status [B Stopped @
Evaluate Configuration Validator
Host Name | ciscoisenew? v
Posture Troubleshooting
EndPoint Debug Network Interface | GigabitEthernet 0 v
TCP Dump
2 Promiscuous Mode  ® On off
Session Trace Tests
» TrustSec Tools Filter | S

Example: 'ip host helios and not iceburg'

Format | Raw Packet Data v
Ste|
Step 4
Step 5 While you keep the TCP Dump running, log in to QRadar and reconfigure the App settings page.

Stop the dump collection and download the .pcap file.

Analyze the .pcap file using Wireshark and observe if there are any packets being dropped,
Certificate exchange failing, or Unknown CA alert.
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TCP Dump to Check if pxGrid Logs are Available in QRadar

In this section, we are going to run few tcpdump commands in QRadar, to verify if pxGrid Logs are
available in QRadar database, if the pxGrid Dashboard is not loading with data, or the Log Activity
search does not show the pxGrid Events.

Take SSH to QRadar console.

Find the PxGrid docker IP:

/opt/qradar/support/recon ps

Step ! /opt/qradar/support/recon connect <<App ID>>
Step 2
ifconfig (Ip associates with the inet addr)
Run this command > tcpdump -nnAse -i any host <<PxGrid Docker Ip Address>> and port 514. Wait
for few minutes if the Events are available on your ISE for the subscribed topic, then you should
Step 3 see events showing up in LEEF Format.

Uploading Logs with the case

Upload the following logs with the case can help our engineers assist you further:

e (qradar.error

e startup.log
1. e app.log
To get gradar.error logs, first we need to SSH to QRadar Console.
2. QRadar error logs are available in this location: /var/log/qradar.error

1.
5 To get startup.log and app.log, first we need to get inside pxGrid App docker:

Login to QRadar console (putty/terminal).

4. Get the pxGrid APP ID execute this command: /opt/qradar/support/recon ps.
> The startup.log and app.log are available in this location: /store/docker/volumes/qapp-<<App
ID>>/log.

Replace App ID with pxGrid App ID from Step 2.
For example: /store/docker/volumes/qapp-110.
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